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capitoLo 1

Introduzione

Questa ¢ la guida utente per il software QGIS sistema informativo geografico (GIS). QGIS & soggetta alla GNU
General Public License. Ulteriori informazioni sono disponibili nella home page di QGIS, https://www.qgis.org.

11 contenuto di questo documento ¢ stato scritto e verificato al meglio delle conoscenze degli autori e dei redattori.
Tuttavia, possono esserci errori.

Pertanto, gli autori, i redattori e gli editori non si assumono alcuna responsabilita per gli errori contenuti nel presente
documento e per le loro possibili conseguenze. Vi invitiamo a segnalare eventuali errori.

Questo documento ¢ stato realizzato con reStructuredText. E” disponibile come codice sorgente reST via github
<https.//github.com/qgis/QGIS-Documentation> e online come HTML e PDF su https://www.qgis.org/en/docs/. Le
versioni tradotte di questo documento possono essere visualizzate e scaricate attraverso I'area di documentazione del
progetto QGIS.

Per ulteriori informazioni su come contribuire a questo documento e sulla sua traduzione, visitare il sito https://qgis.
org/en/site/getinvolved/index.html.

Collegamenti presenti in questo documento

Questo documento contiene collegamenti interni ed esterni. Cliccando su un collegamento interno puoi spostarti
all’interno del manuale, mentre cliccando su un collegamento esterno si aprira un indirizzo internet.

Autori e Redattori della Documentazione

L’elenco delle persone che hanno contribuito a scrivere, rivedere e tradurre il seguente documento & disponibile al
seguente link Hanno contribuito.

Copyright (c) 2004 - 2020 QGIS Development Team
Internet: https://www.qgis.org
Licenza di questo documento

E garantito il permesso di copiare, distribuire e/o modificare questo documento in base ai termini della GNU
Free Documentation License, Versione 1.3 o ogni versione successiva pubblicata dalla Free Software Foundation;
senza alcuna sezione non modificabile, senza testo di copertina e retro-copertina. Una copia della licenza ¢ inclusa
nell’appendice
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1.1 Novita in QGIS 3.16

Questa versione di QGIS include centinaia di correzioni di bug e molte nuove caratteristiche e miglioramenti, rispetto
alla precedente LTR. Si consiglia di utilizzare questa versione rispetto alle versioni precedenti. Per un elenco delle
nuove funzionalita, visitare i changelog visuali all'indirizzo https://qgis.org/en/site/forusers/visualchangelogs.html.

2 Capitolo 1. Introduzione
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CAPITOLO 2

Premessa

Benvenuti nel meraviglioso mondo dei Sistemi Informativi Geografici (GIS)!

QGIS ¢ un Sistema Informativo Geografico Open Source. Il progetto ¢ nato a maggio del 2002 ed ¢ stato confermato
come progetto su SourceForge a giugno dello stesso anno. Abbiamo lavorato sodo per creare un software GIS (che
normalmente ¢ software proprietario e molto costoso) disponibile per chiunque possieda un personal computer. QGIS
attualmente funziona sulla maggior parte delle piattaforme Unix, Windows e OS X. QGIS viene sviluppato usando
gli strumenti software Qt (https://www.qt.io) e il linguaggio C++. Questo significa che QGIS ha un’interfaccia utente
(GUI) snella, piacevole e facile da usare.

QGIS vuole essere un GIS di facile utilizzo, che ha funzionalita e tratta entita di uso generale. L’obiettivo iniziale
del progetto era quello di essere un visualizzatore di dati GIS. QGIS ha raggiunto I'obiettivo di essere utilizzato per
le esigenze quotidiane di visualizzazione di dati GIS, per I'acquisizione di dati, per le analisi GIS avanzate e per le
presentazioni sotto forma di mappe, atlanti e report sofisticati. QGIS supporta un’ampia gamma di formati di dati
raster e vettoriali, con un nuovo supporto di formato che puo essere facilmente aggiunto utilizzando I'architettura a
plugin.

QGIS ¢ rilasciato sotto la GNU General Public License (GPL). Lo sviluppo di QGIS con questa licenza significa
che puoi ispezionare e modificare il codice sorgente e garantisce che tu, nostro utente, avrai sempre accesso a un
programma GIS libero e privo di costi che potrai liberamente modificare. Insieme alla copia di QGIS dovresti aver
ricevuto anche una copia completa del testo della licenza che puoi trovare anche nell’ Appendice di questo manuale
Appendice A: GNU General Public License.

Suggerimento: Documentazione aggiornata

La versione piu recente di questo documento ¢ sempre disponibile nell’area documentazione del sito web QGIS
all'indirizzo https://www.qgis.org/en/docs/.



https://www.qt.io
https://www.qgis.org/en/docs/

QGIS Desktop 3.16 User Guide

4 Capitolo 2. Premessa



CAPITOLO 3

Convenzioni

Questa sezione descrive le convenzioni e gli stili che verranno usati in questo manuale.

3.1 Convenzioni per I'interfaccia grafica

Le convenzioni stilistiche per I'interfaccia grafica hanno lo scopo di imitarne I'effettivo aspetto. In generale, lo stile
presentato nel manuale fa riferimento a cid che compare nell’interfaccia grafica e non ai messaggi che compaiono se
il cursore del mouse si ferma sopra un pulsante.

L’ombreggiatura caratterizza un componente dell'interfaccia grafica che ¢ cliccabile.

Opzioni di menu: Layer » Aggiungi raster oppure Impostazioni » Barre degli strumenti » Digitalizzazione

Strumenti: ® g3 Aggiungi raster
Pulsante : Salva come predefinito
Titolo finestra di dialogo: Proprieta layer

Scheda (tab): Generale
Casella di controllo: B Visualizzatore

Pulsante di scelta: - ® Postgis SRID -+ EPSG ID
Seleziona un numero: %0 ¥

Seleziona una stringa: =)
Cerca un file: ....

N -

—eeee

Seleziona un colore:
Cursore: | =

Inserimento testo: Display name lakes.shp|
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3.2 Convenzioni per il Testo o la Tastiera

Questo manuale include anche convenzioni stilistiche relative al testo, a comandi da tastiera e a parti di codice che
identificano costrutti diversi come classi o metodi. Questi stili non corrispondono all’attuale aspetto di nessun testo o
codice presente in QGIS.

 Link ipertestuali: https://qgis.org

* Combinazioni di tasti: Ct r 1+B significa premere il tasto B mentre si tiene premuto il tasto Ctrl.
¢ Nome di un file: 1akes.shp

¢ Nome di una classe: NewLayer

e Metodo: classFactory

* Server: myhost.de

¢ Inserimento di testo utente: gqgis ——-help

I frammenti di codice sono identificati con un carattere a spaziatura fissa:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

3.3 Istruzioni specifiche per un sistema operativo

Sequenze GUI e piccole quantita di testo possono essere formattate in linea: Click D ey File X QOGIS » Esci per
chiudere QGIS. Cio indica che su piattaforme Linux, Unix e Windows, ¢ necessario prima fare clic sul menu File,
quindi su Esci, mentre su piattaforme macOS, ¢ necessario prima fare clic sul menu QGIS, quindi su Esci.

I testi di grandi dimensioni possono venire formattati come elenco:

)

fai questo

o £7 fai quello

. )( o fai questo

0 come paragrafi:

A X fai questo e questo e questo. Quindi fai questo e questo, e questo.

” . . .
&7 fai questo. Poi fai questo € questo € questo , € ancora € ancora € ancora, € ancora € ancora € ancora, € ancora €
ancora.

Gli screenshot che compaiono in tutta la guida utente sono stati creati su piattaforme diverse.
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capitoLo 4

Funzionalita

QGIS offre un’ampia gamma di funzioni GIS, fornite dalle funzionalita di base e dai plugin. La barra di ricerca rende
facile la selezione di funzioni, di set di dati e altro ancora.

Di seguito viene presentato un breve riassunto delle sei tipologie generali di funzionalita e plugin, seguito dai primi
approfondimenti sulla console Python integrata.

4.1

Visualizzazione dati

Puoi visualizzare una combinazione di dati vettoriali e raster (in 2D o 3D) in differenti formati e proiezioni senza
convertirli in un formato interno o comune. I formati supportati includono:

Tabelle e viste con dati spaziali che usano PostGIS, SpatiaLite e MS SQL Spatial, Oracle Spatial e vettori
supportati dalla libreria OGR, inclusi GeoPackage, ESRI shapefile, MapInfo, SDTS, GML e molti molti altri.
Vedi la sezione Lavorare con i vettori.

Raster e immagini supportati dalla libreria GDAL (Geospatial Data Abstraction Library), come GeoTIFF,
ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG e molti altri ancora, vedi la sezione Lavorare con i dati
raster.

Dati mesh (sono supportati i TIN e le griglie regolari). Vedi Lavorare con i dati Mesh.
Tessere Vettoriali
Raster e vettori GRASS dai relativi database (location/mapset), vedi la sezione Integrazione con GRASS GIS.

I dati spaziali online resi disponibili come OGC Web Services, compresi WMS, WMTS, WCS, WEFS e WFES-T.
Vedere la sezione Lavorare con i protocolli OGC / ISO.

Il sistema di autenticazione QGIS aiuta a gestire utenti/password, certificati e chiavi per servizi web e altre
risorse.

Fogli di calcolo (ODS / XLSX)

Sono supportati i dati temporali .
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4.2 Esplorare dati e comporre mappe

Puoi creare delle mappe ed esplorare i dati spaziali con un’interfaccia grafica molto facile da usare. L’interfaccia
grafica ti mette a disposizione molti strumenti, fra cui:

¢ QGIS Browser

* Riproiezione al volo

e DB Manager

¢ Layout di stampa

* Report

 Pannello vista generale

* Segnalibri spaziali

 Note testuali

* Funzioni di identificazione/selezione

» Modifica/visualizzazione/ricerca degli attributi

« Etichettatura con dati definiti dall’'utente

» Simbologia definita dall’utente per vettori e raster
* Creazione atlante

* Freccia nord, barra di scala ed etichetta di copyright per le mappe

 Supporto per il salvataggio e il ripristino di progetti

4.3 Creazione, modifica, gestione ed esportazione dati

Puoi creare, modificare, gestire ed esportare i vettori e i raster in molti formati. QGIS offre quanto segue:
 Strumenti di digitalizzazione vettoriale
* Possibilita di creare e modificare molti formati di file e layer vettoriali GRASS
* Plugin georeferenziatore per geocodificare le immagini

¢ Strumenti GPS per importare ed esportare il formato GPX, e convertire altri formati GPS in GPX o
scaricare/caricare direttamente su un’unitd GPS (su Linux, usb: ¢ stato aggiunto all’elenco dei dispositivi GPS).

* Supporto per la visualizzazione e la modifica di dati OpenStreetMap

* Possibilita di creare tabelle di database spaziali dai file con il plugin DB Manager
* Gestione delle tabelle di database spaziali migliorata

» Strumenti per gestire le tabelle degli attributi di un vettore

« Salvataggio di schermate come immagini georiferite

» DXF-Export strumento con avanzate capacita di esportare stili e plugin in grado di attivare funzioni tipo CAD.
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4.4 Analisi dei dati

Puoi effettuare analisi di dati spaziali su banche dati spaziali e altri formati supportati da OGR. QGIS offre attualmente
strumenti di analisi vettoriale, analisi raster, campionamento, geoprocessing, gestione delle geometria e dei database.
Puoi inoltre utilizzare gli strumenti integrati di GRASS, che comprendono le funzionalita complete di oltre 400
moduli di GRASS (vedi sezione Integrazione con GRASS GIS). Oppure, puoi lavorare con il plugin Processing, che
fornisce un potente framework di analisi geospaziale per richiamare algoritmi nativi e di terze parti da QGIS, come
GDAL, SAGA, GRASS, R e altri (vedi la sezione Introduzione). Tutte le funzioni di analisi vengono eseguite in
background, consentendoti di continuare il tuo lavoro prima della fine dell’elaborazione.

Il modellatore grafico ti permette di combinare / concatenare funzioni in un flusso di lavoro completo in un ambiente
grafico intuitivo.

4.5 Pubblicazione di mappe su internet

QGIS puo essere utilizzato come client WMS, WMTS, WMS-C o WES e WFES-T (vedi sezione Lavorare con i
protocolli OGC / ISO), e il server QGIS (vedi QGIS-Server-manual) ti permette di pubblicare i tuoi dati attraverso i
protocolli WMS, WCS e WFS su Internet utilizzando un webserver.

4.6 Estendi le funzionalita di QGIS attraverso i plugin

Puoi adattare QGIS ai tuoi scopi grazie all’architettura estensibile dei plugin e alle librerie che possono essere usate
per la creazione di plugin. Ma puoi anche creare le tue nuove applicazioni con C++ o Python!

4.6.1 Plugin di base

I plugin di base includono:
1. DB Manager (scambia, modifica e visualizza layer e tabelle da/su database; esegue interrogazioni in SQL)
. Validatore geometria (controlla gli errori delle geometrie)
. Georeferenziatore raster (aggiunge ai raster informazioni sulla proiezione utilizzando GDAL)

2
3
4. Strumenti GPS (carica e importa dati GPS)
5. GRASS 7 (integra il GIS GRASS)

6

. Client Catalogo MetaSearch (interfaccia con i servizi di catalogazione dei metadati che supportano lo standard
OGC Catalog Service for the Web (CSW))

~

Editing Offline (permette la modifica offline e la sincronizzazione con i database)
8. Processing (il framework per I'elaborazione di dati spaziali di QGIS)

9. Validatore topologico (trova errori topologici nei layer vettoriali)

4.4. Analisi dei dati 9
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4.6.2 Plugin esterni in python

QGIS offre un crescente numero di plugin Python esterni creati dalla comunita. Questi plugin sono presenti all’interno
del repository ufficiale dei plugin e possono essere facilmente installati usando I'installatore dei plugin python. Vedi
Sezione La finestra di dialogo Plugins.

4.7 Console python

Per lo scripting, & possibile usufruire di una console Python integrata, che puo essere aperta con: Plugins » Python
Console. La console si apre come finestra di utilita non modale. Per I'interazione con 'ambiente QGIS, c’¢ la variabile
gqgis.utils.iface,cheeun’istanzadi QgisInterface. Questainterfaccia fornisce I'accesso al canvas della
mappa, ai menu, alle barre degli strumenti e ad altre parti dell’applicazione QGIS. Puoi creare uno script, quindi
trascinarlo e rilasciarlo nella finestra di QGIS e verra eseguito automaticamente.

Per ulteriori informazioni su come lavorare con la console Python e programmare i plugin e le applicazioni QGIS,
fare riferimento a Console python di QGIS e PyQGIS-Developer-Cookbook.

4.8 Problemi noti

4.8.1 Limitazione numero di file aperti

Se stai aprendo un grande progetto di QGIS e sei sicuro che tutti i layer sono validi, ma qualche layer viene
segnalato come corrotto, probabilmente ti stai scontrando con questo problema. Linux (e probabilmente anche altri
sistemi operativi) hanno un limite di file aperti per ogni processo. I limiti delle risorse e per ogni processo vengono
automaticamente ereditati. Il comando ul imit, preinstallato nella console dei comandi, cambia i limiti solo per il
processo attuale; il nuovo limite viene ereditato da ogni altro processo.

Puoi vedere tutti gli ulimit attuali digitando:

’$ ulimit -aS

Poi vedere I'attuale numero permesso di file aperti per ogni processo con questo comando da console:

’$ ulimit -Sn

Per cambiare i limiti di una sessione esistente, potresti usare qualcosa del genere:

$ ulimit -Sn #number of_ allowed open_files
$ ulimit -Sn
$ qgis

Risolverlo per sempre

Sulla maggior parte dei sistemi Linux, i limiti alle risorse sono impostati al momento del login tramite il
modulo pam_1imits in funzione delle impostazioni contenute in /etc/security/limits.conf o /etc/
security/limits.d/*.conf. Dovresti modificare questi file sei hai i permessi di amministratore (anche
tramite sudo), ma dovrai effettuare di nuovo il login prima che i cambiamento siano effettivi.

Maggiori informazioni:

https://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/  https://linuxaria.com/article/
open-files-in-linux
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CAPITOLO D

Come Iniziare

Questo capitolo fornisce una rapida panoramica sull'installazione di QGIS, su dati campione scaricabili dal sito di
QGIS e su come avviare una prima semplice sessione in cui visualizzare dati raster e dati vettoriali.

5.1 Installare QGIS

11 progetto QGIS fornisce differenti modi per installare QGIS in base alla tua piattaforma.

5.1.1 Installazione da eseguibile

Sono disponibili pacchetti di installazione standard per £7 MS Windows e )( macOS. Pacchetti binari (rpm e deb) o

repository software sono disponibili per molte versioni di GNU/Linux {:\.

Per ulteriori informazioni e istruzioni per il tuo sistema operativo consulta https://download.qgis.org.

5.1.2 Installazione da codice sorgente

Se vuoi generare QGIS dal codice sorgente, fai riferimento alle istruzioni per l'installazione. Sono distribuite con il
codice sorgente QGIS in un file chiamato INSTALL. Puoi anche trovarle online all’indirizzo https://github.com/qgis/
QGIS/blob/master/INSTALL.md.

Se vuoi generare un particolare release e non la versione in sviluppo, dovresti sostituire master con il nome del
release (comunemente nella versione release—-X_Y) nel link di cui sopra (le istruzioni di installazione potrebbero
essere differenti).
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5.1.3 Installazione su supporti esterni

E possibile installare QGIS (con tutti i plugin e le impostazioni) su una flash drive. Questo si ottiene definendo
un’opzione —profiles-path che sovrascrive il percorso predefinito user profile e costringe QSettings ad usare anche
questa cartella. Vedere la sezione Impostazioni di sistema per ulteriori informazioni.

5.1.4 Installare dati campione

Questa guida utente contiene esempi basati sul dataset di esempio di QGIS (chiamato anche dataset Alaska).
Scarica i dati di esempio da https://github.com/qgis/QGIS-Sample-Data/archive/master.zip e decomprimi 'archivio
in qualsiasi posizione conveniente sul tuo sistema.

L’insieme di dati Alaska comprende tutti i dati GIS usati per gli esempi e le schermate nel manuale utente, e include
anche un piccolo database GRASS. La proiezione per I'insieme di dati campione di QGIS ¢ Alaska Albers Equal
Area con unita in piedi. Il codice EPSG ¢ 2964.

PROJCS["Albers Equal Area'",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY ["EPSG","7008"]1],
TOWGS84([-3,142,183,0,0,0,01,
AUTHORITY["EPSG","6267"]1],
PRIMEM["Greenwich", O,
AUTHORITY["EPSG","8901"17,
UNIT["degree",0.0174532925199433,
AUTHORITY ["EPSG","9108"]],
AUTHORITY["EPSG","4267"17,
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER(["standard_parallel_1",55],
PARAMETER|["standard_parallel_ 2", 6517,
PARAMETER["latitude_of_center", 507,
PARAMETER(["longitude_of center",-1547,
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Se vuoi usare QGIS come interfaccia grafica per GRASS, puoi trovare una selezione di dati di esempio (per
esempio Spearfish o South Dakota) direttamente dal sito ufficiale GRASS GIS, https://grass.osgeo.org/download/
sample-data/.

5.2 Avviare e uscire da QGIS

L’avvio di QGIS puo essere fatto in modo analogo a quello che tu generalmente fai per altre applicazioni sul tuo
sistema. Ci0 significa che puoi avviare QGIS:

e usando A il menu Applicazioni, £7 il menu Start o X il Dock
* doppio clic sull’icona nella tua cartella Applicazioni o sul collegamento sul desktop

 facendo doppio clic su un file di progetto QGIS esistente (con estensione .ggz o .ggs). Nota che questo
aprira anche il progetto.

* digitando ggis nel prompt dei comandi (supponendo che QGIS sia aggiunto al tuo PATH o che tu sia nella
sua cartella di installazione)

Per uscire da QGIS, usa:

<D T'opzione del menu Progetto » Esci da QGIS o usa la scorciatoia Ct r1+Q
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. X QGIS » Quit QGIS, o usa la scorciatoia Cnd+Q

* oppure utilizza la croce rossa nell’angolo in alto a destra dell'interfaccia principale dell’applicazione.

5.3 Sessione di esempio: caricare layer raster e vettoriali

Ora che hai QGIS installad e un sample dataset disponibile, mostreremo una prima sessione di esempio. In questo
esempio, visualizzeremo un layer raster e un layer vettoriale. Useremo:

« il layer raster landcover (gqgis_sample_data/raster/landcover.img)
* e il layer vettoriale 1akes (gqgis_sample_data/gml/lakes.gml)
Dove qgis_sample_data rappresenta il percorso del dataset decompresso.
1. Avvia QGIS come visto in Avviare e uscire da QGIS.
2. Per caricare i file in QGIS:
1. Clicca sull’icona g Apri Gestore della sorgente dati 7] Data Source Manager dovrebbe aprirsi in modalita
Browser.
2. Sfoglia la cartella ggis_sample_data/raster/

3. Seleziona il file IMG ERDAS landcover. img e fai doppio clic su di esso. Il layer landcover viene
aggiunto in background mentre la finestra Data Source Manager rimane aperta.

Data Source Manager | Browser

I Browser Browser
T QE&THO
. Vector » [ QGIS a
» [ QGIs-Documentation
Raster
* » [ QGISTraining-Data
A% Mesh » [ QGIS-Website
i ——
+ [ qgis_sample_data
o Delimited Text > [ climate
_ ¥ [ esv
S GeoPackage ¥ 5 gml
= lakes.gml
# 4 SpatiaLite » [1gps
» [ grassdata
4 PostgresQL » [ projects
~ [ raster
& MS5S0L = colortable landcover.bxt

= landcover.img

" SR_50M_alaska_nad.tif
» [ shapefiles
» B alaska.sqlite

» [ screenshots

DBE‘_ DB2

m Virtual Layer

\ﬁi_ WMS/WMTS

» @ labels
£ wes > macenfig.png .
= & options_searchbox resize.png
+ WFS .:".save_style_qml.png
» [ qgis_issues
ArcGIs Map » [ scan
Server » [ shapefile
ArcGIS Feature » [ system Volume Information

J% 5
S & First_launch.png

GeoNode » = landuse.sqlite
* » = training_data.gpkg

| R,

Fig. 5.1: Aggiungere dati a un nuovo progetto in QGIS
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4. Per caricare i dati dei laghi, sfoglia la cartella qgis_sample_sample_data/gml/, e fai doppio
clic sul file ‘file:"lakes.gml per aprirlo.

5. Si apre la finestra di dialogo Selettore Sistema di Riferimento delle Coordinate. Nel menu Filtro, digita
2964, si ottiene di seguito la lista filtrata dell’elenco dei sistemi di riferimento delle coordinate.

Coordinate Reference System Selector 8

Specify CRS for layer lakes

Filter | . 2964]

Recently used coordinate reference systems

Coordinate Reference System Authority ID

1 ]
Coordinate reference systems of the world Hide deprecated CRSs

Coordinate Reference System Authority ID
~ [ Projected Coordinate Systems
~ Albers Equal Area

NAD27 / Alaska Albers EPSG:2964

NAD27 / Alaska Albers

Extent
172.42,51.30,-129.99, 71.40

Proj4
+proj=aea +lat_1=55 +lat_2=65 +lat_0=50
+lon_0=-154 +x_0=0 +y_0=0 +datum=NAD27 S
+units=us-ft +no defs Y -

@Help % cancel « 0K

Fig. 5.2: Seleziona il Sistema di Riferimento delle Coordinate

6. Select the NAD27 / Alaska Albers entry
7. Fai clic su OK
8. Chiudi la finestra Gestore della sorgente dati.
Ora hai i due layer disponibili nel tuo progetto in alcuni colori casuali. Facciamo qualche personalizzazione sul layer
laghi.
1. Seleziona lo strumento éﬂ-) Ingrandisci g11a barra degli strumenti Gestisci la barra di navigazione
2. Fai zoom su un’area con alcuni laghi
3. Fai doppio click sul layer 1akes nella legenda per aprire la finestra di dialogo Proprieta.

4. Per cambiare il colore dei laghi:

1. Clicca sulla scheda (f Simbologia e seleziona blu come colore di riempimento.

2. Seleziona blu come colore di riempimento
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"Fi Information

‘t’;‘_- Source

“’ symbology

Diagrams
W# 3D View
E Source Fields

Attributes
Form

Joins

L Auxiliary
L Storage

@ Actions
. Display
a. Rendering

Variables

ah Metadata

™ Dependencies

| = single symbol

.| @Help || style -

Layer Properties - lakes | Symbology

[T simple Fill

%)
Unit | Millimeter - |
Opacity 111000% <
Color | |'|
| Q. Favorites | &%
_d 2NN
gradient gray 3 fill hashed black/  hashed black  hashed black X outline blue
plasma -

b Layer Rendering

Fig. 5.3: Selezione del colore dei laghi

3. Premi OK. I laghi sono ora visualizzati in blu nella mappa.

5. Per visualizzare i nomi dei laghi:

1. Riapri la finestra di dialogo Proprieta del layer 1akes.
2. Clicca sulla scheda ‘=< Etichette

|save symbol| | Advanced -

| «/Apply || %cancel |’ o OK ]

3. Seleziona Etichette singole nel menu a discesa per abilitare I'etichettatura.

4. Dalla lista Efichetta con, scegli il campo Nomi.

5.3. Sessione di esempio: caricare layer raster e vettoriali

15



QGIS Desktop 3.16 User Guide

Layer Properties - lakes | Labels x

. Display

L]

p Type case | No change
4 Rendering

=1 Single labels v ||
q Information Label with [ah{ NAMEQ bt ] &
v Text Sample
‘:t\ Source -
%. symbology Lorem Ipsum
Labels %
= Lorem Ipsum | |01 - | | B -
y Diagrams
5 Text -
3D View +ab i
Ny o Forfr:attlng Font Ubuntu -l e
abe
E Source Fields Buffer
@ Background style Regular ="
Attributes ) Shadow
Form % Placement uelsle =/ =
Joins _/ Rendering | Size 10.0000 ==
L Auxiliary Points K=
<M Storage
Color . |
{;@ Actions
Opacity 100.0 % ;| G
(El
L=t

1k

Spacing letter | 0.0000

Variables 1 »

[ Metadata .| @Help Style - « Apply || % cancel

Fig. 5.4: Visualizzazione del nome dei laghi

&,
o]
=

5. Premi Applica. I nomi ora passeranno sopra i confini.
6. Puoi migliorare la leggibilita delle etichette aggiungendo un buffer bianco intorno ad esse:

1. Clicca sulla scheda Buffer nella lista sulla sinistra

2. Seleziona i Disegna buffer del testo
3. Scegli 3 come dimensione del buffer
4. Fai clic su Applica
5. Controlla se il risultato ¢ buono e, se necessario, aggiorna il valore.
6. Infine clicca OK per chiudere la finestra di dialogo Proprieta vettore e applicare le modifiche.
Aggiungiamo ora alcune decorazioni per migliorare la mappa ed esportarla da QGIS:
1. Seleziona il menu Visualizza » Decorazioni » Barra di scala
Nella finestra di dialogo che si apre, spunta 'opzione oA Attiva Barra di Scala
Personalizza le opzioni nella finestra di dialogo come preferisci

Premi Applica

wook wn

Analogamente, dal menu decorazioni, aggiungi altre voci (freccia nord, copyright....) alla mappa con proprieta
personalizzate.

6. Clicca Progetto » Importa/Esporta w ﬁ'ﬁ Esporta Mappa come Immagine...

7. Premi Salva nella finestra di dialogo aperta

8. Seleziona il percorso del file, il formato e conferma cliccando Salva ancora.
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=]
9. Premi Progetto » Salva per memorizzare le modifiche come file di progetto . ggz.

Ecco fatto! Puoi vedere quanto sia facile visualizzare i layer raster e vettoriali in QGIS, configurarli e generare la
tua mappa in un formato immagine che puoi usare in altri software. Passiamo ad approfondire le funzionalita, le
caratteristiche e le impostazioni disponibili e come usarle.

Nota: Per continuare ad imparare QGIS attraverso esercizi passo dopo passo, utilizza il Training manual.

5.3. Sessione di esempio: caricare layer raster e vettoriali 17
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CAPITOLO O

Lavorare con i File di Progetto

6.1 Introduzione ai progetti QGIS

Lo stato della tua sessione QGIS si chiama progetto. QGIS lavora su un progetto alla volta. Una impostazione pud
essere per lo specifico progetto o una impostazione predefinita a livello di applicazione per i nuovi progetti (vedi la
sezione Opzioni). QGIS puo salvare lo stato del tuo spazio di lavoro in un file di progetto QGIS project file usando le

. =
opzioni di menu Progetto » 1 Salva o Progetto » =14 Salva Con Nome....

Nota: Se il progetto ¢ stato modificato il simbolo * apparira nella barra del titolo e QGIS, per default, ti chiedera se

vuoi salvare le modifiche. Questo comportamento & controllato dall'impostazione . Chiedi di salvare il progetto e
cambia sorgente dati quando richiesto in Impostazioni » Opzioni » Generale.

Puoi caricare progetti esistenti in QGIS dal pannello Browser o attraverso Progetto » Apri..., Progetto » Nuovo
da Modello o Progetto » Apri Recenti ».

All’'avvio, viene visualizzata una lista di Modelli di Progetto e Progetti Recenti, che include screenshot, nomi e percorsi
dei file (per un massimo di dieci progetti). La lista Progetti Recenti & utile per accedere ai progetti usati di recente.
Fai doppio clic su una voce per aprire il progetto o il modello di progetto. Puoi anche aggiungere un layer per creare
automaticamente un nuovo progetto. Le liste scompariranno quindi, lasciando il posto alla rappresentazione nell’area
di disegno della mappa.

Se vuoi iniziare una nuova sessione, scegli Progetto » D Nuovo. In questo modo ti sara chiesto di salvare il progetto
esistente se sono state apportate modifiche da quando ¢ stato aperto o salvato I'ultima volta.

Quando apri un nuovo progetto, la barra del titolo mostrera Progetto Senza Titolo fino a quando non lo
salvi.
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Untitled Project - QGIS
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Fig. 6.1: Aprire un nuovo progetto in QGIS

Le informazioni salvate in un file di progetto includono:
* Layer aggiunti
* Quali layer sono interrogabili
* Proprieta dei layer, inclusi i simboli e gli stili associati
* Proiezione usata per la mappa
¢ Ultima estensione della mappa
e Layout di stampa
¢ Gli elementi del layout di stampa con le impostazioni
* Le impostazioni del layout di stampa dell’atlante
 Settaggi dei parametri di digitalizzazione
¢ Relazioni tra le tabelle
¢ Macro di progetto
» Stili predefiniti per il Progetto
 Settaggi dei Plugin
¢ Impostazioni del Server QGIS dalla scheda Impostazioni OWS nelle proprieta del Progetto
* Query memorizzate nel DB Manager

Il file di progetto viene salvato in formato (vedi QGS/QGZ - 1l File di Formato di Progetto QGIS). Questo significa che
puoi modificare il file al di fuori di QGIS se sai cosa stai facendo. Il formato del file di progetto ¢ stato aggiornato pil
volte. I file di progetto delle vecchie versioni di QGIS potrebbero non funzionare piti correttamente.
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Nota: Per impostazione predefinita, QGIS ti avvertira delle differenze di versione. Questo comportamento ¢

controllato nella scheda Generale del Impostazioni » Opzioni (B Awvisa quando viene aperto un file di progetto
salvato con una vecchia versione di QGIS).

Ogni volta che salvi un file di progetto . ggs in QGIS, viene creato un backup del file nella stessa directory del file
di progetto, con I'estensione . ggs-~.

L’estensione per i progetti QGIS ¢ . ggs ma quando si salva da QGIS, il default ¢ quello di salvare usando un formato
compresso con l'estensione . ggz. Il file . ggs € incorporato nel file . ggz (un archivio in formato zip), insieme al
suo database sqlite associato (. ggd) per auxiliary data. Puoi accedere a questi file decomprimendo il file . ggz.

Nota: Il meccanismo Proprieta Dati Ausiliari rende particolarmente utile un progetto zippato, poiché incorpora dati
ausiliari.

I progetti possono anche essere salvati/caricati in/da un database PostgreSQL utilizzando le seguenti voci del menu
Progetto:

* Progetto » Apri da
* Progetto » Salva su

Entrambe le voci di menu hanno un sotto-menu con una lista di implementazioni extra per la memorizzazione
del progetto (PostgreSQL e GeoPackage). Cliccando sull’azione si aprira una finestra di dialogo per scegliere una
connessione GeoPackage e un progetto o una connessione PostgreSQL, schema e progetto.

I progetti memorizzati in Geopackage o PostgreSQL possono essere caricati anche attraverso il pannello del browser
QGIS, sia facendo doppio clic su di essi che trascinandoli sulla visualizzazione della mappa.

6.2 Gestire i percorsi corrotti di file

Quando si apre un progetto, QGIS potrebbe non riuscire a raggiungere alcune fonti di dati a causa di servizio/base
dati non disponibile, o a causa di un file rinominato o spostato. QGIS apre quindi la finestra di dialogo Gestione Layer
Non Disponibili, facendo riferimento ai layer non trovati. Puoi:

* Fare doppio clic nel campo Sorgente dati, aggiustare il percorso di ogni layer e cliccare Applica le modifiche;
* Selezionare una riga, premere Sfoglia per individuare la posizione corretta e cliccare su Applica Modifiche;

* Premere Auto-Ricerca per sfogliare le cartelle e provare a correggere automaticamente tutti i percorsi interrotti
o quello(i) selezionati(i). Bisogna essere essere consapevoli del fatto che la ricerca puo richiedere un certo
tempo.

* Ignorare il messaggio e aprire il tuo progetto con il percorso (o 1 percorsi) interrotti cliccando su Mantieni Layer
Non Disponibili. 11 tuo layer viene quindi visualizzato nel pannello Layer, ma senza dati fino a quando non si

. . PN i ibile! .
fissa il percorso usando I'icona £ Lavernon disponibile! accanto ad esso nel pannello Layer, o Ripara Sorgente
Dati... nel menu contestuale del layer.

Con lo strumento Ripara Sorgenti Dati, una volta che un percorso di un layer ¢ stato riparato, QGIS scansiona
tutti gli altri percorsi interrotti e cerca di riparare automaticamente quelli che hanno lo stesso percorso di file
interrotto.

o W Rimuovi Layer Non Disponibili dal progetto.
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6.3 Generazione output

Ci sono diversi modi per generare output dalla sessione QGIS. Abbiamo gia discusso il salvataggio come file di
progetto in Introduzione ai progetti QGIS. Altri modi per produrre file di output sono:

 Creazione di immagini: Progetto » Importa/Esporta » =5 Esporta Mappa come Immagine... esporta la mappa
in un formato immagine (PNG, JPG, TIFF...) in scala, risoluzione, dimensione personalizzate, ... E possibile
la georeferenziazione dell'immagine. Vedi Esportare la visualizzazione della mappa per maggiori dettagli.

 Esportazione in file PDF: Progetto » Importa/Esporta » Esporta Mappa in PDF... esporta la mappa in PDF in
scala, risoluzione personalizzate e con alcune impostazioni avanzate (semplificazione, georeferenziazione, ...).
Vedi Esportare la visualizzazione della mappa per maggiori dettagli.

* Esportare in file DXF: Progetto » Importa/Esportat » Esporta Progetto in DXF... apre una finestra di dialogo
dove puoi definire lal “Modalita simbologia”, 1a “Scala simbologia” e i layer vettoriali che vuoi esportare in DXF.
Attraverso la “Modalita simbologia”, i simboli della Simbologia originale di QGIS possono essere esportati con
alta fedelta (vedi la sezione create_dxf_f_files).

» Stampare le mappe: Progetto » h Nuovo Layout di Stampa... apre una finestra di dialogo dove ¢ possibile
impaginare e stampare I'area di disegno della mappa corrente (vedi sezione Layout di stampa).
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QGIS GUI

L’interfaccia grafica utente (GUI) di QGIS & mostrata nella figura sottostante (i numeri da 1 a 5 in cerchi gialli
indicano elementi importanti della GUI QGIS, e sono discussi di seguito).

Project Edit View Layer Settings Plugins Vector Raster _Databa1

documentation3.qgs - QGIS
leb Mesh Processing Help

DEBE Veppliprp. i\fﬂ__sil:@e QG-6-8-5

g Q@ g

Browser Processing Toelbox
LIEEREXS %408 9 A
& v - Favorites [= Q search...

» [¥ Project Home R tly d
V; » " spatial Bookmarks gc:::o“gr;:;;
.’E} b [&) Home 3 @ Database

» [/ @ File tools
ﬁ @ GeoPackage @ Graphics
2 / Spatialite Q@ Interpolation
It ) @ postcis @ Layer tools

: MSSQL = @ Network analysis
v (1 Raster analysis

S AwT &R

[ regions
+ v/ ¥ landcover
» [ & sR_som_alaska_nad

3

@ Raster terrain analysis
(@ Raster tools

@ vector analysis é)
@ Vector creation

Q@ Vector general

@ Vector geometry

@ Vector overlay

@ Vector selection

@ vector table

# Climb

#m GDAL

& GRASS

*: Models

& scripts

Layer Styling ‘ Processing Toolbox

Q Type to locate (Ctrl+K)

5 ' Coordinate | 176.2207,67.2258 | % S(ile‘l:‘!n?:ﬂlﬁﬁ ‘-‘ @ Magnifier | 100%

‘;‘ Rotation |0,0°

|| Render @ psc:2sea @

Fig. 7.1: QGIS GUI con i dati di esempio Alaska

Nota: L’aspetto delle finestre (barra del titolo, ecc.) potra apparire diverso a seconda del sistema operativo e
dell’ambiente desktop.

L’interfaccia grafica principale (GUI) di QGIS (Fig. 7.1) ¢ composta da cinque aree/parti diverse:

1. Menu Bar
2. Toolbars
3. Panels

4. Map View
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5. Status Bar

Sfoglia di seguito per una spiegazione dettagliata di queste funzionalita.

7.1 Barra dei Menu

La barra dei Menu fornisce accesso alle varie funzioni di QGIS utilizzando un menu gerarchico standard. I Menu,
le relative opzioni, le icone associate e le scorciatoie da tastiera sono descritti di seguito. Le scorciatoie da tastiera
possono essere riconfigurate (Impostazioni » Scorciatoie da Tastiera).

La maggior parte delle opzioni dei menu hanno uno strumento corrispondente e viceversa. Tuttavia, i menu non sono
organizzati esattamente come le barre degli strumenti. Le posizioni delle opzioni di menu nelle barre degli strumenti
sono indicate nella tabella seguente. I plugin possono aggiungere nuove opzioni ai menu. Per ulteriori informazioni
sugli strumenti e le barre degli strumenti, vedi Barre degli strumenti.

Nota: QGIS ¢ un’applicazione multipiattaforma. Gli strumenti siano disponibili su tutte le piattaforme, ma possono
essere posizionati in menu differenti, a seconda dei diversi sistemi operativi. Gli elenchi che seguono mostrano le
posizioni pitl comuni, comprese le variazioni note.

7.1.1 Progetto

Il menu Progetto fornisce le opzioni di accesso e di uscita del project files. Fornisce gli strumenti per:

* Creare un Nuovo file da zero o utilizzando un altro file di progetto come modello (vedi Project files options per
la configurazione del modello)

e Apri.... un progetto da un file, un GeoPackage o un database PostgreSQL
* Chiudi un progetto o riportalo al suo ultimo salvataggio

e Salva un progetto in formato .qggs o .ggz, o come file o all'interno di un GeoPackage o di un database
PostgreSQL

» Esporta la mappa in diversi formati o utilizza un print layout per output pitt complessi.

* Imposta le proprieta del progetto e le opzioni di aggancio per la modifica della geometria.
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Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
D Nuovo Ctrl+N Progetto | Introduzione ai progetti QGIS
Nuovo da Modello » Introduzione ai progetti QGIS
Apri... Ctrl+0 Progetto | Introduzione ai progetti QGIS
Apri Da »
» GeoPackage... Introduzione ai progetti QGIS
» PostgreSQL... Introduzione ai progetti QGIS
Apri Recenti » Alt+J+R Introduzione ai progetti QGIS
Chiudi Introduzione ai progetti QGIS
=]
Salva Ctrl+s Progetto | Introduzione ai progetti QGIS
=]
Salva come... Ctrl+Shift+S Progetto | Introduzione ai progetti QGIS
Salva su »
» Modelli... Introduzione ai progetti QGIS
» GeoPackage... Introduzione ai progetti QGIS
» PostgreSQL... Introduzione ai progetti QGIS
Ripristina...
Proprieta... Ctrl+Shift+P Proprieta progetto
Opzioni di aggancio... Impostare la Tolleranza di
Aggancio e il raggio di ricerca
degli elementi
Importa/Esporta »
- S Esporta Mappa come Immagine... Esportare la visualizzazione
della mappa
- ’!N Esporta Mappa come PDF... Esportare la  visualizzazione
della mappa
» Esporta Progetto in DXF... Creazione di nuovi file DXF
» Importa Vettori da DWG/DXF... Importare file DXF o DWG
D Nuovo Layout di Stampa... Ctrl+P Progetto | Layout di stampa
|D Nuovo Report... Creare un Report
’Ti\q Gestore del Layout... Progetto | Layout di stampa
Layout » Layout di stampa
_@Esci da QGIS Ctrl+Q

In X macOS, il comando Exit QGIS corrisponde a QGIS » Esci da QGIS (Cd+Q).

7.1.2 Modifica

Il menu Modifica fornisce la maggior parte degli strumenti nativi necessari per modificare gli attributi dei layer o la

geometria (vedi Modifica per i dettagli).

Voce di Menu Scorciatoia Barra Riferimento

degli

Strumenti
4_:" Annulla Ctrl+2z DigitalizzazioneAnnullare e rispristinare
@ Ripristina Ctrl+Shift+Z | DigitalizzaziopeAnnullare e rispristinare

continues on next page

7.1. Barra dei Menu
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Tabella 7.1 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
=2 Taglia geometrie Ctrl+X Digitalizzaziopel ugliare,  copiare  ed
incollare elementi
E Copia geometrie Ctrl+C Digitalizzazionélagliare,  copiare ed
incollare elementi
% Incolla geometrie Ctrl+Vv Digitalizzazionélagliare, — copiare ed
incollare elementi
Incolla Elementi Come » Lavorare con la tabella
degli attributi
» Crea Vettore... Lavorare con la tabella
degli attributi
» Nuovo Vettore Temporaneo... Ctrl+Alt+V Lavorare con la tabella
degli attributi
Seleziona » Selezionare elementi
> E?: Seleziona Elemento(i) Seleziona Selezionare elementi
> E?- Seleziona Elementi con un Poligono Seleziona Selezionare elementi
> Eil% Seleziona Elementi a Mano Libera Seleziona Selezionare elementi
> E&TE Seleziona Elementi con un Cerchio Seleziona Selezionare elementi
> Seleziona Elementi per Valore... F3 Seleziona Selezionare elementi
- @':‘ Seleziona Elementi con Espressione... Ctrl+F3 Seleziona Selezionare elementi
> IE’} Deseleziona Elementi da Tutti i Layer Ctrl+Alt+A Seleziona Selezionare elementi
> Du] Deseleziona Elementi dal Layer Atfivo | Ctr1+Shift+A | Seleziona Selezionare elementi
Attuale
» Riseleziona Elementi Selezionare elementi
|
» 1 Seleziona Tutti gli Elementi Ctrl+A Seleziona Selezionare elementi
- |:| Inverti Selezione Elementi Seleziona Selezionare elementi
% Aggiungi elemento Ctrl+. Digitalizzazione
L]
® 3 Aggiungi Elemento Puntuale Ctrl+. DigitalizzazioneAggiungere Elementi
oo
® [0 Aggiungi Elemento Lineare Ctrl+. DigitalizzazioneAggiungere Elementi
=)
£ Aggiungi Elemento Poligonale Ctrl+. DigitalizzazioneAggiungere Elementi
& 3 Aggiungi geometria circolare Digitalizzare | Aggiungere arco
Forme circolare
s 3 Aggiungi geometria circolare dal raggio Digitalizzare | Aggiungere arco
Forme circolare
Aggiungi Cerchio » Digitalizzare | Disegnare cerchi
Forme
» L3 Aggiungi Cerchio da 2 Punti Digitalizzare | Disegnare cerchi
Forme
» L3 Aggiungi Cerchio da 3 Punti Digitalizzare | Disegnare cerchi
Forme

continues on next page
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Tabella 7.1 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
™
» L3 Aggiungi Cerchio da 3 Tangenti Digitalizzare | Disegnare cerchi
Forme
0O
> Aggiungi Cerchio da 2 Tangenti e un Punto Digitalizzare | Disegnare cerchi
Forme
- Aggiungi Cerchio da un Centro e un Altro Digitalizzare | Disegnare cerchi
Punto Forme
Aggiungi Rettangolo » Digitalizzare | Disegnare Rettangoli
Forme
» L1 Aggiungi Rettangolo da Estensione Digitalizzare | Disegnare Rettangoli
Forme
_— Aggiungi Rettangolo da un Centro e un Digitalizzare | Disegnare Rettangoli
Punto Forme
» "LF Aggiungi Rettangolo da 3 Punti (Distanza Digitalizzare | Disegnare Rettangoli
dal 2° e 3° Punto) Forme
» L1 Aggiungi Rettangolo da 3 Punti (Distanza Digitalizzare | Disegnare Rettangoli
dal punto proiettato sul segmento pl e p2) Forme
Aggiungi Poligono Regolare » Digitalizzare | Disegnare Poligoni
Forme Regolari
. Aggiungi Poligono Regolare da un Centro e Digitalizzare | Disegnare Poligoni
un Punto Forme Regolari
- Aggiungi Poligono Regolare da un Centro e Digitalizzare | Disegnare Poligoni
un Angolo Forme Regolari
» L] Aggiungi Poligono Regolare da 2 Punti Digitalizzare | Disegnare Poligoni
Forme Regolari
Aggiungi Ellisse » Digitalizzare | Disegnare Ellissi
Forme
z
» L1 Aggiungi Ellisse da un Centro e 2 Punti Digitalizzare | Disegnare Ellissi
Forme
» L1 Aggiungi Ellisse da un Centro e un Punto Digitalizzare | Disegnare Ellissi
Forme
» L3 Aggiungi Ellisse da Estensione Digitalizzare | Disegnare Ellissi
Forme
. Aggiungi Ellisse da Fuochi Digitalizzare | Disegnare Ellissi
Forme
Aggiungi Nota » Note testuali
- @ Text Annotation Attributi Note testuali
» - Form Annotation Attributi Note testuali
BT
» -~ HTML Annotation Attributi Note testuali
> SVG Annotation Attributi Note testuali
% Muovi geomertria(e) Digitalizzaziopépostare Elemento(i)
Avanzata

continues on next page
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Tabella 7.1 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
% Copia e Sposta Elemento(i) Digitalizzaziopépostare Elemento(i)
Avanzata
Elimina Selezionato Digitalizzaziond-liminare Elementi
Selezionati
[
L fJ,/ Modifica Attributi Elementi Selezionati DigitalizzaziondVlodifica dei valori nella
tabella degli attributi
% Ruota geometria(e) DigitalizzaziopeRuotare Elemento(i)
Avanzata
% Semplifica geometria Digitalizzazionéemplificare Elemento
Avanzata
g3 Aggiungi buco DigitalizzazioneAggiungere buco
Avanzata
% Aggiungi parte DigitalizzazioneAggiungere Parte
Avanzata
@ . P I
LJ Riempi buco DigitalizzaziopdRiempire buco
Avanzata
3 Elimina buco Digitalizzaziond:liminare buco
Avanzata
8%‘ Elimina parte Digitalizzaziond:liminare Parte
Avanzata
(P Modifica geometrie Digitalizzaziondlodificare forma
Avanzata Elementi
@ Curva di offset DigitalizzaziondCurve di Offset
Avanzata
ap 1 .
o% Dividi geometrie DigitalizzaziopndDividere Elementi
Avanzata
oo 1 .
&% Dividi parti DigitalizzaziopdDividere Parti
Avanzata
E Unisci geometrie selezionate Digitalizzaziond ondere elementi
Avanzata selezionati
.
== Fondi Attributi Elementi Selezionati Digitalizzaziond ondere attributi  degli
Avanzata elementi selezionati
(merge)
"7':{ Strumento Vertice (per tutti i vettori) Digitalizzazionétrumento Vertice
; % Strumento Vertice (Layer attivo) Digitalizzazionétrumento Vertice
>3
(’ Ruota i simboli per i punti DigitalizzaziondRuotare Simboli Punto
Avanzata
A J
7 Offset simboli punti Digitalizzazionéffset dei simboli per i
Avanzata punti

continues on next page
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Tabella 7.1 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
& Invertire Linea Digitalizzaziopdnversione linea
Avanzata
I
o't Tronca/estendi Elemento Digitalizzazionél roncare/Estendere
Avanzata Elemento

Gli strumenti che dipendono dalla tipologia di geometria del layer selezionato, cio¢ punto, polilinea o poligono,
vengono attivati di conseguenza:

Voce di Menu Punto Polilinea Poligono
OO o q pa
Sposta Elemento(i) ] = %
o° A\ &
Copia e sposta geometria(e) = o=

7.1.3 Mappa

La mappa viene visualizzata nell’area mappa. Puoi interagire con queste visualizzazioni utilizzando gli strumenti
Visualizza (vedi Lavorare sulla mappa per maggiori informazioni). Per esempio, puoi:

* Creare nuove visualizzazioni di mappe 2D o 3D accanto all’area di disegno della mappa principale
e Zoom or pan in una zona
* Interrogare gli attributi o le geometria degli elementi visualizzati
* Migliorare la visualizzazione della mappa con le modalita di anteprima, le annotazioni o le decorazioni
* Accedere ai diversi pannelli o barre degli strumenti
Il menu ti permette anche di riorganizzare l'interfaccia QGIS stessa utilizzando azioni come:
* Attiva schermo intero: copre l'intero schermo nascondendo la barra del titolo.

e Attiva Visibilita Pannello: mostra o nasconde pannelli attivi panels - utile per la digitalizzazione di elementi
(per la massima visibilita della mappa) cosi come per presentazioni (proiettate/registrate) utilizzando la mappa
principale di QGIS

e Attiva solo la Mappa: nasconde pannelli, barre degli strumenti, menu e barra di stato e mostra solo la mappa.
In combinazione con I'opzione a schermo intero, visualizza sul tuo schermo solo la mappa

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
Nuova Visualizzazione Mappa Ctrl+M Mappa
Nuova Visualizzazione Mappa 3D Ctrl+Alt+M Visualizzazione Mappa
3D
Liy
‘i]_J Sposta Mappa Navigazione| Zoom e Pan
Mappa
o . o
¥+ Sposta la mappa sulla selezione Navigazione
Mappa
&'*-!-’I Ingrandisci Ctrl+Alt++ Navigazione| Zoom e Pan
Mappa

continues on next page
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Tabella 7.2 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
&I’T’I Rimpicciolisci Ctrl+Alt+- Navigazione| Zoom e Pan
Mappa
QR Informazione elementi Ctrl+Shift+I Attributi Informazione Elementi
Misura » Attributi Misurazioni
[—
» ™ Misura linea Ctrl+Shift+M Attributi Misurazioni
0]
» M Misura area Ctrl+Shift+J Attributi Misurazioni
» M Misura angolo Attributi Misurazioni
z Sintesi delle statistiche Attributi Pannello Statistiche
JI Zoom completo Ctrl+Shift+F Navigazione| Zoom e Pan
Mappa
V7 '\I
2~ Zoom alla selezione Ctrl+Jd Navigazione| Zoom e Pan
Mappa
_
; ~ Zoom sul layer Navigazione| Zoom e Pan
Mappa
1)
gf_,, Zoom alla risoluzione originale (100%) Navigazione| Zoom e Pan
Mappa
2 Ultimo zoom Navigazione| Zoom e Pan
Mappa
2H Zoom successivo Navigazione| Zoom e Pan
Mappa
Proprieta » Alt+V+D Decorazioni
- E Reticolo... Reticolo
» & Barra di Scala... Barra di Scala
- q Immagine... Decorazione Immagine
- ﬁh Freccia Nord... Freccia Nord
- -rﬂ Titolo Etichetta... Etichetta Titolo
» & Etichetta Copyright... Etichetta Copyright
> ”__E!J Estensione del Layout... Estensione del Layout
Modalita anteprima »
» Normale
» Simula Fotocopia (Scala di grigi)
» Simula Fax (Monocolore)
» Simula il daltonismo (Protanopia)
» Simula il daltonismo (Deuteronopia)
& Mostra Suggerimenti Mappa Attributi Proprieta Suggerimenti
E Nuovo Segnalibro Spaziale... Ctrl+B Navigazione| Segnalibri Spaziali
Mappa
B
”J Mostra Segnalibri Spaziali Ctrl+Shift+B Navigazione| Segnalibri Spaziali
Mappa

continues on next page
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Tabella 7.2 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
L
”J Mostra Gestore Segnalibri Spaziali Segnalibri Spaziali
~l
R Aggiorna EF5 Navigazione
Mappa
® Mostra tutti i layers Ctrl+Shift+U Pannello dei Layer
™= Nascondi tutti i layers Ctrl+Shift+H Pannello dei Layer

1 Mostra layer selezionati

Pannello dei Layer

“=A Nascondi layer selezionati

Pannello dei Layer

;‘% Mostra Layer Selezionati

Pannello dei Layer

Mostra Layer Selezionati in modo indipendente

Pannello dei Layer

“=| Nascondi layer non selezionati

Pannello dei Layer

Pannelli »

Pannelli e Barre degli
strumenti

» Digitalizzazione Avanzata

1l Pannello di
Digitalizzazione
Avanzata

» Browser

1l Pannello Browser

» Browser (2)

1l Pannello Browser

» Informazioni sul GPS

Tracciamento live GPS

» Strumenti GRASS Integrazione con GRASS
GIS

» Ordine Layer Pannello  Ordine  dei
Layer

» Stile Layer Pannello Stile Layer

» Layer Pannello dei Layer

» Messaggi di log Pannello Messaggi di

Log

» Panoramica

Pannello Panoramica

» Strumenti di Processing

Gli Strumenti di
Processing

» Visualizzatore risultati

Gli Strumenti di
Processing

» Opzioni di Aggancio e Digitalizzazione

Impostare la Tolleranza
di Aggancio e il raggio di
ricerca degli elementi

» Gestore Segnalibri Spaziali

Segnalibri Spaziali

» Statistiche

Pannello Statistiche

» Scala dei Tasselli

Impostazioni tasselli

» Annulla/Ripristina

Pannello
Annulla/Ripristina

Barre degli strumenti »

Pannelli e Barre degli
strumenti

» Barra degli strumenti di Digitalizzazione
Avanzata

Digitalizzazione
avanzata

» Barra degli strumenti relativi agli Attributi

» Barra degli strumenti per la Gestione delle
Sorgenti Dati

Gestione fonti dati

» Barra del Database

continues on next page
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Tabella 7.2 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti

» Barra degli strumenti di Digitalizzazione Modifica di un layer
esistente

» Barra della Guida

» Barra degli strumenti per le Etichette Barra delle etichette

» Barra degli strumenti di Gestione dei Layer Gestione fonti dati

» Barra degli strumenti di Navigazione Mappa

» Barra dei Plugin Plugin

» Barra del Progetto

» Barra degli strumenti Raster

» Seleziona Barre degli strumenti Selezionare elementi

» Barra degli strumenti di Digitalizzazione di Digitalizzare forme

Forme

» Barra degli strunenti di Aggancio Impostare la Tolleranza
di Aggancio e il raggio di
ricerca degli elementi

» Barra del vettore

» Barra Web

» GRASS Integrazione con GRASS
GIS

Attiva la modalita a schermo intero F11

Attiva/Disattiva visibilita pannello Ctrl+Tab

Attiva solo la Mappa Ctrl+Shift+Tab

In Linux KDE, Pannelli», Barre degli strumentim e Attiva schermo intero sono nel menu Impostazioni.

7.1.4 Layer

Il menu Layer fornisce un ampio set di strumenti per create nuove fonti dati, per add a un progetto o per save
modifications. Usando le stesse fonti di dati, puoi anche:

* Duplica un layer per generare una copia dove puoi modificare il nome, lo stile (simbologia, etichette, ...), i
collegamenti, ... La copia utilizza la stessa fonte dati dell’originale.

* Copia e Incolla layer o gruppi da un progetto all’altro come una nuova istanza le cui proprieta possono essere
modificate in modo indipendente. Come per Duplica, i layer sono ancora basati sulla stessa fonte dati.

* 0 Layer e Gruppi Incorporati.... da un altro progetto, come copie di sola lettura che non ¢ possibile modificare

(vedi Progetti nidificati)

Il menu Layer contiene anche strumenti per configurare, copiare o incollare le proprieta del layer (stile, scala, SR...).

Voce di Menu Scorciatoia Barra degli | Riferimento
Strumenti
m Gestore della sorgente dati Ctrl+L Gestore della | Opening Data
sorgente dati
Crea Layer » Creare nuovi layer Vettore
> @ Nuova Layer GeoPackage... Ctrl+Shift+N| Gestore della | Creare un nuovo vettore
sorgente dati GeoPackage
> ﬂ\‘f" Nuovo Shapefile... Gestore della | Creare un nuovo layer
sorgente dati Shapefile
continues on next page
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Tabella 7.3 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra degli | Riferimento
Strumenti
> /;j Nuovo Layer SpatialLite... Gestore della | Creare un nuovo layer
sorgente dati SpatiaLite
- Iﬁl Nuovo Vettore Temporaneo... Gestore della | Creare un nuovo Vettore
sorgente dati Temporaneo
- m Nuovo Layer Virtuale... Gestore della | Creazione di layer virtuali
sorgente dati
Aggiungi Layer » Accedere ai dati
- VS Aggiungi Layer...... Ctrl+Shift+V | Gestione Layer Caricare un layer da un file
» "9 Aggiungi Raster... Ctrl+Shift+R| Gestione Layer Caricare un layer da un file
- ﬁg Aggiungi Mesh... Gestione Layer Caricare un layer mesh
> ,EJ Aggiungi  Layer  Testo | Ctr1+Shift+T | Gestione Layer Importare  file di testo
Delimitato... delimitato
- ID Aggiungi Layer PostGIS... Ctrl+Shift+D| Gestione Layer Strumenti riferiti ai Database
- ﬁé Aggiungi Layer SpatialLite... Ctrl+Shift+L| Gestione Layer Layer SpatiaLite
> 2 Aggiungi Layer MSSQL Spatial. .. Gestione Layer Strumenti riferiti ai Database
- QJ Aggiungi Layer Oracle Spatial... Gestione Layer Strumenti riferiti ai Database
- Aggiungi Layer DB2 Spatial... Ctrl+Shift+2 | Gestione Layer Strumenti riferiti ai Database
> @ Aggiungi/Modifica  Layer Gestione Layer Creazione di layer virtuali
Virtuale...
> & Aggiungi Layer WMS/WMTS... Ctrl+Shift+W| Gestione Layer Caricare layer WMS/WMTS

- Aggiungi Layer XYZ...

Usare i servizi di Tasselli
XYZ

- @ Aggiungi Layer ArcGIS Map
Service...

Gestione Layer

> % Aggiungi Layer WCS...

Gestione Layer

Client WCS

> (VEJ Aggiungi Layer WFS...

Gestione Layer

Client WFS e WES-T

- @E Aggiungi Layer ArcGIS Feature
Service...

Gestione Layer

> @J Aggiungi Layer Vector Tile...

Includi Layers e Gruppi...

Progetti nidificati

Aggiungi da un file di definizione del
layer...

File di definizione Layer

Copia Stile

Salvare e condividere le
proprieta di un layer

Incolla Stile

Salvare e condividere le
proprieta di un layer

Copia Layer

Incolla Layer/Gruppo

continues on next page
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Tabella 7.3 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra degli | Riferimento
Strumenti
[==]
Apri tabella attributi F6 Attributi Lavorare con la tabella degli
attributi
& Attiva modifiche Digitalizzazione Modifica di un layer esistente
=]
Salva modifiche vettore Digitalizzazione Salvare i layer modificati
;-# Modifiche in uso » Digitalizzazione Salvare i layer modificati
» Salva Vettore(i) Selezionato(i) Digitalizzazione Salvare i layer modificati
»  Rollback per il(i) Vettore(i) Digitalizzazione Salvare i layer modificati
selezionato(i)
» Annulla per il Vettore(i) Selezionato(i) Digitalizzazione Salvare i layer modificati
» Salva per tutti i Vettori Digitalizzazione Salvare i layer modificati
» Rollback per tutti i Vettori Digitalizzazione Salvare i layer modificati
» Annulla per tutti i Vettori Digitalizzazione Salvare i layer modificati
Salva con nome... Creare nuovi layer da layer
esistente
Salva come file di definizione del layer... File di definizione Layer
Q Elimina Layer/Gruppo Ctrl+D
D Duplica Layer(s)
Definisci la scala di visibilita del/dei
Layer(s)
Imposta SR del/dei Layer(s) Ctrl+Shift+C Sistemi di Riferimento delle
coordinate e layer
Imposta SR del Progetto dal Layer Sistemi di Riferimento delle
coordinate e Progetti
Proprieta vettore... La finestra di dialogo
Proprieta dei vettori,
Proprieta raster, Proprieta
del Dataset Mesh
Filtra... Ctrl+F Costruttore di interrogazioni
(sbe| Etichettatura Proprieta etichette
& Mostra nella Panoramica Pannello Panoramica
O9 Mostra tutto nella Panoramica Pannello Panoramica
Nascondi tutto dalla Panoramica Pannello Panoramica
7.1.5 Impostazioni
Voce di Menu Riferimento
Profili Utente »- Lavorare con i Profili Utente
» default Lavorare con i Profili Utente
» Apri la Cartella del Profilo Attivo Lavorare con i Profili Utente
» Nuovo Profilo... Lavorare con i Profili Utente
[ V4

B a Gestore di stile...

1l Gestore di Stile

< Proiezione personalizzata...

Sistema di Riferimento delle Coordinate Personalizzato

]
[0 Scorciatoie da tastiera. ..

Tasti di scelta rapida

i L .
[om Personalizzazione interfaccia....

Personalizzazione

RS Opzioni...

Opzioni
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In Linux KDE, troverai altri strumenti nel menu Impostazioni come Panelli », Barre degli strumenti » ¢ Attiva

modalita schermo intero.

7.1.6 Plugin

Voce di Menu Scorciatoia Barra degli | Riferimento
Strumenti
@ Gestire e installare Plugin... La finestra di dialogo Plugins
Console Python Ctrl+Alt+P Plugin Console python di QGIS

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.

7.1.7 Vettore

Questo ¢ cid che appare nel menu Vetfore se tutti i plugin di base sono abilitati.

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
Q Controlla Geometrie... Plugin Controllo Geometria
E‘a Strumenti GPS Alt+0+G Vettore Plugin GPS
_E Validatore Topologico Vettore Plugin Validatore topologico
Strumenti di Geoprocessing » Alt+0+G
» Buffer... Buffer
» Ritaglia... Ritaglia
» Poligono Convesso... Poligono convesso
» Differenza... Differenza
» Dissolvi... Dissolvi
» Intersezione... Intersezione
» Differenza Simmetrica... Differenza simmetrica
» Unione... Unione
» Elimina i poligoni selezionati... Elimina i poligoni selezionati
Strumenti di Geometria » Alt+0+E
» Centroidi... Centroidi
» Raggruppa geometrie... Raggruppa geometrie
» Estrai Vertici... Estrai vertici
» Da parti multiple a parti singole... Da parti multiple a parti singole
» Da Poligoni a Linee... Da poligoni a linee
» Semplifica... Semplifica
» Controlla validita... Controllo validita
» Triangolazione di Delaunay... Triangolazione di Delaunay
» Infittisci secondo un conteggio... Infittisci secondo un conteggio
» Aggiungi Antributi alla Geometria. .. Aggiungi attributi della geometria
» Da Linee a Poligoni... Da linee a poligoni
» Poligoni di Voronoi... Poligoni di Voronoi
Strumenti di Analisi » Alt+O+A
» Intersezioni Linee... Intersezione linee
» Media coordinate... Media coordinate
» Statistiche elementari per campi... Statistiche elementari per campi
» Conta i punti nel poligono... Conta i punti nel poligono

continues on next page
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Tabella 7.4 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra Riferimento
degli
Strumenti
» Matrice di Distanza... Matrice di distanza
» Lista valori univoci... Lista valori univoci
» Analisi vicino piit prossimo... Analisi vicino pitt prossimo
» Somma lunghezza linee... Somma lunghezze linea
Strumenti di Gestione Dati » Alt+0+D
» Fondi vettori (Merge)... Fondi vettori (merge)
» Riproietta Layer... Riproietta layer
» Crea indice spaziale... Crea indice spaziale
» Unisci attributi per posizione... Unisci attributi per posizione
» Dividi vettore... Dividi vettore
Strumenti di Ricerca » Alt+0+R

» Selezione per posizione...

Seleziona per posizione

» Estrai estensione del Layer...

Estrazione estensione layer

» Punti casuali nell’estensione. ..

Punti casuali nell’estensione

» Punti casuali nell estensione del Layer...

Punti casuali nei confini del layer

» Punti casuali dentro poligoni...

Punti casuali dentro poligoni

» Selezione csuale...

Selezione casuale

» Selezione casuale con un sottoinsieme...

Estrazione casuale allinterno  di

sottoinsiemi

» Punti regolari...

Punti regolari

Per impostazione predefinita, QGIS aggiunge algoritmi Processing al menu Vettore, raggruppati per sotto-menu.
Questo fornisce scorciatoie per molte comuni operazioni sui dati GIS vettoriali provenienti dalle diverse fonti. Se
non tutti questi sotto-menu sono disponibili, abilita il plugin Processing in Plugins » Gestisci e installa Plugins.....

Da notare che I'elenco degli strumenti del menu Vetfore pud essere esteso con altri algoritmi di Processing o tramite

algoritmi esterni plugins.

7.1.8 Raster

Questo ¢ cio che appare nel menu Raster se tutti i plugin di base sono abilitati.

Voce di Menu Scorciatoia Barra | Riferimento

degli

Strumenti

Calcolatore Raster... Calcolatore raster

Allinea Raster... Allineamento Raster
j:v-"_ Georeferenziatore ALt+R+ G Raster | Georeferenziatore
Analisi »
» Esposizione... Esposizione

» Riempimento nullo...

Riempimento nullo

» Interpolazione (media mobile)...

Interpolazione (media mobile)

» interpolazione (misure dei dati)...

Interpolazione (misure dei dati)

» interpolazione (distanza  inversa

ponderata)...

Interpolazione (distanza inversa

ponderata)

» interpolazione (vicino pitt prossimo)...

Interpolazione (IDW con ricerca del
vicino pitt prossimo)

» Ombreggiatura... Ombreggiatura
» Prossimita (distanza raster)... Prossimita (distanza raster)
» Asperita... Asperita

continues on next page
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Tabella 7.5 - continua dalla pagina precedente

Voce di Menu Scorciatoia Barra | Riferimento
degli
Strumenti

» Filtro... Filtro

» Pendenza... Pendenza

» Indice di Posizione Topografica (TPI)...

Indice di Posizione Topografica (TPI)

» Indice di Asperita Terreno (TRI)...

Indice di Asperita Terreno (TRI)

Proiezioni »

» Assegna proiezione...

Assegna proiezione

» Estrai proiezione...

Estrai proiezione

» Warp (Riproiezione)...

Riproiezione

Miscellanea »

» Crea raster virtuale. ..

Crea raster virtuale

» Informazioni del raster...

Informazioni del raster

» Fondi (merge)...

Fondi (merge)

» Crea panoramiche (piramidi)...

Crea panoramiche (piramidi)

» Indice dei tasselli...

Indice dei tasselli

Estrazione »

» Ritaglia Raster da Estensione...

Ritaglia raster da estensione

» Ritaglia il Raster con Maschera...

Ritaglia il raster con maschera

» Curve di livello. ..

Curve di livello

Conversione »

» da PCT a RGB...

Da PCT a RGB

» Poligonizzazione (da raster a vettore)...

Poligonizzazione (da raster a vettore)

» Rasterizza (da vector a raster)...

Rasterizza (da vettore a raster)

» da RGB a PCT...

Da RGB a PCT

» Translate (converti formato)...

Translate (converti formato)

Per impostazione predefinita, QGIS aggiunge gli algoritmi Processing al menu Raster, raggruppati per sotto-menu.
Questo fornisce una scorciatoia per molti comuni compiti di diversi fornitori GIS riferiti ai raster . Se non tutti questi
sotto-menu sono disponibili, abilita il plugin Processing in Plugins » Gestisci e installa Plugins.....

Nota che I'elenco degli strumenti del menu Raster pud essere esteso con qualsiasi algoritmo di Processing o con alcuni

algoritmi esterni plugins.

7.1.9 Database

Questo ¢ cio che appare nel menu Database se tutti i plugin di base sono abilitati. Se non sono abilitati i plugin del

database, non ci sara il menu Database.

Voce di Menu Scorciatoia Barra degli | Riferimento
Strumenti
Editing Offline... Alt+D+0O Plugin Offline Editing
- ¥ Converti a Progetto Offline... Database Plugin Offline Editing
ap
» 554 Sincronizza Database Plugin Offline Editing
i DB Manager... Database Plugin DB Manager

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.
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7.1.10 Web

Questo ¢ cid che appare nel menu Web se tutti i plugin di base sono abilitati. Se non sono abilitati i plugin Web, non
ci sard il menu Web.

Voce di Menu Scorciatoia Barra degli | Riferimento

Strumenti
MetaSearch » Alt+W+ M Client Catalogo MetaSearch
> @ Metasearch Web Client Catalogo MetaSearch
» Help Client Catalogo MetaSearch

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.

7.1.11 Mesh

Il menu Mesh fornisce gli strumenti necessari per manipolare i mesh layers.

Voce di Menu Scorciatoia Barra degli | Riferimento
Strumenti

% Calcolatore Mesh. ..

7.1.12 Processing

Voce di Menu Scorciatoia Barra Riferimento
degli
Strument
W Barra strumenti Processing | Ctr1+A1t+T Gli Strumenti di Processing
" Modellatore grdfico... Ctrl+Alt+G 1l modellatore grafico
i\-:> Storico Ctrl+Alt+H 1l gestore della cronologia di Processing
Visualizzatore Risultati Ctrl+Alt+R Configurazione di applicazioni esterne
¥ Modifica geometrie sul Il processamento di modifiche al layer sul
posto posto

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.
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7.1.13 Guida

Voce di Menu Scorciatoia Barra degli | Riferimento
Strumenti

I:| Contenuti della Guida Fl Guida

Documentazione sulle API

Plugin »

Segnala un problema
Serve supporto commerciale?

@ Home Page di QGIS Ctrl+H
V" Verifica versione di QGIS

W Informazioni

@ Membri sostenitori di QGIS

7.1.14 QGIS

Questo menu ¢ disponibile solo in X macOS e contiene alcuni comandi relativi a tale sistema operativo.

Voce di Menu Scorciatoia
Preferenze

Aiuto su QGIS
Nascondi QGIS
Mostra tutto
Nascondi gli altri
Esci da QGIS Cmd+Q

Preferences corrisponde a Impostazioni » Opzioni, About QGIS corrisponde a Guida » Informazioni and Quit QGIS
corrisponde a Progetto » Esci da QGIS nelle altre piattaforme.

7.2 Pannelli e Barre degli strumenti

Dal menu Visualizza (o Impostazioni), puoi attivare e disattivare i widget QGIS (Panelli ») e le barre degli
strumenti (Barre degli strumenti »). Per (dis)attivare uno qualsiasi di essi, clicca con il tasto destro del mouse sulla
barra dei menu o sulla barra degli strumenti e scegli la voce che vuoi. I pannelli e le barre degli strumenti possono
essere spostati e posizionati dove preferisci all'interno dell’interfaccia QGIS. La lista pud anche essere estesa con
lattivazione di Core or external plugins.

7.2.1 Barre degli strumenti

La barra degli strumenti permette di accedere alla maggior parte delle funzioni dei menu, oltre a strumenti aggiuntivi
per interagire con la mappa. Ogni voce della barra degli strumenti ha a disposizione un aiuto a comparsa. Passa il
mouse sopra lo strumento e una breve descrizione dello scopo dello strumento verra visualizzata.

Puoi spostare a piacimento ogni barra in funzione delle tue esigenze. Inoltre puoi disattivare ogni barra cliccando con
il tasto destro sulla barra degli strumenti disattivando la voce relativa nel menu.
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Layer Settings Plugins

Vector Raster Database Web Mesh Processing Help

- New Map View

. New 3D Map View
{"} Pan Map
¥» Pan Map to Selection
& Zoom In
4= Zoom Out
@, Identify Features

Measure

%, Statistical Surnmary
13 Zoom Full
152 Zoom to Selection

{2 Zoom to Layer

¢ Zoom Last

Decorations
Preview Mode
» Show Map Tips
. New Spatial Bookmark...
¥ show Spatial Bookmarks
¥ show Spatial Bookmark Manager
¥ Refresh
@ Show All Layers
Hide all Layers
@, Show Selected Layers
Hide Selected Layers
Hide Deselected Layers
Panels
Toolbars
Toggle Full Screen Mode
Toggle Panel Visibility
Toggle Map Only

Ckrl+m
Cerl+Alt+M

Cerl+Alt++
cerl+Alt+-
Cerl+Shift+l

Cerl+shift+F
Ckrl+J

Ctrl+B
Ctrl+shift+B

F5
Ctrl+shift+U
Ctrl+shift+H

F11
Ctrl+Tab
Ctrl+shift+Tab

-
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v Advanced Digitizing Toolbar

V| Attributes Toolbar

v| Data Source Manager Toolbar
Database Toolbar

| Digitizing Toolbar

v| Help Toolbar

| Label Toolbar
Manage Layers Toolbar

| Map Navigation Toolbar

| Plugins Toolbar

| Project Toolbar

Raster Toolbar

Shape Digitizing Toolbar

Snapping Toolbar

Vector Toolbar

web Toolbar

GRASS

v
v
v
v
v
v| QgsResourceSharing

Fig. 7.2: Il menu Barra degli strumenti

Suggerimento: Ripristinare le barre degli strumenti

Se involontariamente hai nascosto una barra degli strumenti, puoi riattivarla utilizzando pristinarla utilizzando

Visualizza w Barre degli strumenti » (0 Impostazioni » Barre degli strumenti »). Se, per qualsiasi causa, una
barra degli strumenti (o qualsiasi altro widget) scompare completamente dall'interfaccia, puoi trovare suggerimenti

per recuperarla in restoring initial GUI.
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7.2.2 Pannelli

QGIS ha a disposizione molti pannelli. I pannelli sono widget speciali con cui ¢ puoi interagire (selezionando opzioni,

selezionando caselle di controllo, inserendo dati. .

.) per eseguire operazioni piil complesse.

Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

. New Map View
.y New 3D Map View
{ Pan Map
&» Pan Map to Selection
4 Zoom In
4= Zoom Qut
@. Identify Features
Measure
% Statistical Summary
T3 Zoom Full
2 Zoom to Selection

{2 Zoom to Layer

g Zoom Last

Decorations
Preview Mode
+ Show Map Tips
I, New Spatial Bookmark...
' show Spatial Bookmarks
" sShow Spatial Bookmark Manager

f Refresh
@ Show all Layers
Hide All Layers
@, Show Selected Layers
. Hide Selected Layers
| Hide Deselected Layers

Toolbars

Toggle Full Screen Mode
Toggle Panel Visibility
Toggle Map Only

Chrl+M
Cerl+Alt+M

Chrl+Alt++
Cerl+alt+-
Ckrl+Shift+l

Ctrl+shift+F
Ctrl+J

-

Ctrl+B
Ctrl+shift+B

F5
Ctrl+shift+U
Cerl+Shift+H

| panels .,

b
F11
Ctrl+Tab
Ctrl+shift+Tab

BLMS @c-B
Sw® ¥ X

o il e
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Advanced Digitizing |
¥ Browser

Browser (2)

GPS Information
GRASS Tools

Layer Order

Layer Styling

Layers

Log Messages
Overview

¥ Processing Toolbox
Results Viewer
Spatial Bookmark Manager
Statistics

Tile Scale

Undo/Redo

Fig. 7.3: Il menu Pannelli

Di seguito ¢ riportato un elenco dei pannelli predefiniti di QGIS:

¢ il Advanced Digitizing Panel

* il Browser Panel

7.2. Pannelli e Barre degli strumenti
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¢ il GPS Information Panel

* il Identify Panel

e il Layer Order Panel

e il Layer Styling Panel

* il Layers Panel

¢ il Log Messages Panel

¢ il Overview Panel

¢ lo Processing Toolbox

* il pannello Visualizzatore risultati
e il Spatial Bookmark Manager Panel
e il Statistics Panel

e the Tile Scale Panel

* il Undo/Redo Panel

7.3 Mappa

7.3.1 Visualizzazione della mappa

La visualizzazione della mappa (chiamata anche area della mappa) ¢ il «business end» di QGIS — le mappe
sono visualizzate in quest’area, in 2D. La mappa visualizzata in questa finestra riflettera il rendering (simbologia,
etichettatura, visibilita...) che hai applicato ai layer che hai caricato. Dipende anche dai layer e dal Sistema di
Riferimento delle Coordinate (SR) del progetto.

Quando aggiungi un layer (vedi ad esempio Accedere ai dati), QGIS cerca automaticamente il suo sistema di
riferimento delle coordinate. Se un diverso SR & impostato di default per il progetto (vedi Sistemi di Riferimento
delle coordinate e Progetti) allora il layer & «al volo» trasformato in quel SR, e la vista della mappa viene ingrandita
alla massima estensione nell’area di visualizzazione mappa se hai iniziato con un progetto QGIS vuoto. Se ci sono gia
dei layer nel progetto, non viene eseguito alcun ridimensionamento della mappa, quindi solo gli elementi che rientrano
nell’estensione corrente della mappa saranno visibili.

Clicca sulla mappa visualizzata e dovresti essere in grado di interagire con essa:
* la mappa puod essere spostata, traslando la visualizzazione in un’altra zona della mappa: questo viene realizzato

Li;
usando lo strumento {I_AI PanMap 5 tasti freccia, muovendo il mouse mentre viene tenuto premuto uno qualsiasi
dei tasti Space, il tasto centrale del mouse o la rotellina del mouse.
I/"\I I/"\I

* puo essere ingrandita e rimpicciolita, con gli strumenti dedicati 4?.!-’ Rimpicciolisci 4?.!-’ Ingrandisci Tjenj premuto
il tasto A1t per passare da uno strumento all’altro. Lo zoom viene eseguito facendo scorrere la rotellina del
mouse in avanti per ingrandire e indietro per rimpicciolire. Lo zoom ¢ centrato sulla posizione del cursore del
mouse.

Puoi personalizzare il Fattore di zoom nel menu Impostazioni » Opzioni » Strumenti Mappa.

-
* puo essere mgrandlta fino all’estensione completa di tutti i layer caricati (&"" Zoom Completoy ' fing all’estensione
"\

del layer (..L" Zoomsul Layer)  fino all’estensione degli elementi selezionati (?‘ 7 Zoom alla Selezione)

P

* puoi spostarti avanti/indietro nella cronologia della visualizzazione della mappa con i pulsanti #70om Precedente

Pt

e FEPoom Suceessivo o ysando i pulsanti del mouse avanti/indietro.
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Clicca con il tasto destro sulla mappa e dovresti essere in grado di E Copia le coordinate del punto cliccato nel
SR della mappa, in WGS84 o in un SR personalizzato. Le informazioni copiate possono poi essere incollate in
un’espressione, uno script, un editor di testo o un foglio di calcolo...

Per default, QGIS apre una singola vista di mappa (chiamata «mappa principale»), che ¢ strettamente legata al
pannello Layer; la mappa principale riflette automaticamente le modifiche che fai nell’area del pannello Layer. Ma
¢ anche possibile aprire viste aggiuntive della mappa il cui contenuto potrebbe divergere dallo stato corrente del
pannello Layer. Possono essere in 2D o in 3D, mostrare una scala o un’estensione diversa, o visualizzare un diverso
insieme di layer caricati grazie a map themes.

7.3.2 Impostazioni aggiuntive per la visualizzazione mappa

Per aggiungere una nuova visualizzazione mappa, vai in Visualizza » Nuova Mappa. Un nuovo widget fluttuante,
che imita la visualizzazione della mappa principale, viene aggiunto a QGIS. Puoi aggiungere tutte le visualizzazioni
di mappa che vuoi. Possono essere mantenute fluttuanti, affiancate o sovrapposte.
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Layers ® Layer Styling ®
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Fig. 7.4: Visualizzazioni di pill mappe con diverse impostazioni

Nella parte superiore di una mappa aggiunta, c’¢ una barra degli strumenti con le seguenti funzionalita:

L) Tl ) g_‘f.
.« A8 Zoom Completo’ {;b- + Zoom alla Selezione e -~ Zoom sul Layer per navigare allinterno della vista

o @ Impostazione Tema di visualizzazione ner selezionare il map theme da utilizzare nella visualizzazione mappa.. Se
impostato su (nessuna), la visualizzazione seguira i cambiamenti del pannello Layer.

o %, Impostazioni di visualizzazione per configurare la visualizzazione della mappa:

— '® Sincronizza il Centro della Vista con la Mappa Principale: sincronizza il centro della vista della mappa
senza cambiare la scala. Questo permette di avere uno sguardo d’insieme o una mappa ingrandita che
segue il centro della mappa principale.

— i Sincronizza Vista con la Selezione: equivalente a zoom alla selezione

— Scala
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Rotazione

Ingrandimento

- Sincronizza scala con la scala della mappa principale. Si pud quindi applicare un Fattore di scala che
permette di avere una vista che ¢ ad esempio sempre 2x la scala della mappa principale.

_ & Mostra Annotazioni
_ & Mostra Posizione Cursore
- Mostra Estensione Mappa Principale

A Mostra etichette: permette di nascondere le etichette indipendentemente dal fatto che siano impostate
nelle proprieta dei layer visualizzati

Cambia SR della Mappa...

Rinomina Vista...

7.3.3 Esportare la visualizzazione della mappa

Le mappe realizzate possono essere impaginate ed esportate in vari formati utilizzando le funzionalita avanzate del
print layout or report. E anche possibile esportare direttamente la visualizzazione corrente, senza layout. Questo rapido
«screenshot» della visualizzazione della mappa ha alcune utili opzioni.

Per esportare la mappa con la rappresentazione corrente:
1. Vai su Progetto » Importa/Esporta

2. A seconda del formato di output, seleziona
= Esporta Mappa come Immagine...

*0 ‘}v Esporta Mappa come PDF...

I due strumenti hanno in comune diverse opzioni. Nella finestra di dialogo che si apre:

44 Capitolo 7. QGIS GUI



QGIS Desktop 3.16 User Guide

Save Map as Image [~

w Extent (current: user defined)

North |3382891.8955
West |-455697.9058 East 494822.9275

South 2642440.5067
Calculate from Layer - Map Canvas Extent Draw on Canvas
Scale 1:1000000 - | |3

Resolution 96 dpi -

Output width | 1095 px -

Lgy-

Output height | 853 px =
v Draw active decorations: north arrow, scale bar
v/ Draw annotations

v Append georeference information (embedded or via world File)
@Help Copy to Clipboard # Ccancel Zlsave

Fig. 7.5: La finestra di dialogo Salva Mappa come Immagine

1. Scegli 1” Estensione di esportazione: puo essere I'estensione della vista corrente (I'impostazione predefinita),
'estensione di un layer o un’estensione personalizzata disegnata sull’area di visualizzazione della mappa. Le
coordinate dell’area selezionata vengono visualizzate e sono modificabili manualmente.

2. Inserisci la Scala della mappa o selezionala dal predefined scales: cambiando la scala si ridimensionera
I'estensione di esportazione (dal centro).

3. Imposta la Risoluzione dell’output

4. Puoi controllare la Larghezza e 17 Altezza dell'output dell'immagine in pixel : in base alla risoluzione e
all’estensione attuali, possono essere personalizzati e ridimensioneranno I’estensione della mappa (dal centro). Il
rapporto delle proporzioni puo essere bloccato, il che puo essere particolarmente opportuno quando si modifica
I’estensione sulla mappa.

5. . Disegna le decorazioni attive: in uso decorations (barra di scala, titolo, griglia, freccia nord...) vengono
esportate con la mappa

6. o Scrivi annotazioni per esportare le annotation

7. o Aggiunge informazioni georiferimento (includendolo o via world file): a seconda del formato di output, un
world file con lo stesso nome (con estensione PNGW per le immagini PNG, JPGW per JPG, ...) viene salvato
nella stessa cartella della tua immagine. Il formato PDF incorpora le informazioni nel file PDF.

8. Quando si esporta in PDF, sono disponibili altre opzioni nella finestra di dialogo Salva Mappa come PDF...:
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Save Map as PDF .

v Extent (current: map view)
North |9307279.3573
West -2897581.0567 East |4322720.1924

South 3682697.6536
Calculate from Layer - Map Canvas Extent Draw on Canvas
Scale 1:7596153 - | |3

Resolution 96 dpi -

Output width | 1095 px -

Lgy-

Output height | 853 px =
v Draw active decorations: none
v/ Draw annotations

v Append georeference information (embedded or via world File)

¥| Export RDF metadata (title, author, etc.)

v Advanced Settings

Rasterize map
| simplify geometries to reduce output file size

Text export | Always Export Text as Paths (Recommended) -

@Help *® Cancel Usave

Fig. 7.6: La finestra di dialogo Salva Mappa come PDF

. & Esporta RDF metadata del documento come il titolo, I'autore, la data, la descrizione. ..

e ! Crea PDF Geospaziale (GeoPDF): Genera un ‘file PDF georeferenziato
<https://gdal.org/drivers/raster/pdf.html>""_ (richiede GDAL versione 3 o successiva). Puoi:

— Scegli il Formato GeoPDF.
_# Includi informazioni sulle caratteristiche dei vettori nel file GeoPDF: includera tutte le

informazioni sulla geometria e sugli attributi delle caratteristiche dei vettori visibili all'interno della
mappa nel file di output GeoPDF.

Nota: A partire da QGIS 3.10, anche un file GeoPDF puod essere utilizzato come fonte di dati. Per
ulteriori informazioni sul funzionamento di GeoPDF in QGIS, vedere https://north-road.com/2019/09/
03/qgis-3-10-loves-geopdf/.

* Rasterizza mappa

. ESempliﬁca geometrie per ridurre le dimensioni del file in uscita: Le geometrie saranno semplificate
durante I'esportazione della mappa rimuovendo i vertici che non sono distinguibili alla risoluzione di
esportazione (ad esempio, se la risoluzione di esportazione ¢ di 300 dpi, verranno rimossi i vertici che
sonoamenodi 1/600 pollici distanti tra loro). Questo puo ridurre la dimensione e la complessita
del file di esportazione (file molto grandi possono non riuscire a caricarsi in altre applicazioni).
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» Imposta I” Esportazione testo: controlla se le etichette di testo vengono esportate come oggetti di testo
propriamente detti (Esporta Sempre Testo come Oggetti Testo) o solo come percorsi (Esporta Sempre
Testo come Percorso). Se vengono esportati come oggetti di testo, allora possono essere modificati in
applicazioni esterne (p.e. Inkscape) come testo normale. MA leffetto collaterale & che la qualita della
restituzione risulta inferiore. E ci sono problemi con la restituzione quando certe impostazioni di testo
come i buffer sono al loro posto. Questo ¢ il motivo per cui si raccomanda di esportare come percorsi.

9. Fai clic su Salva per selezionare la posizione, il nome e il formato del file.

Quando si esporta come immagine, il risultato atteso delle impostazioni di cui sopra puo essere salvato in Copia
negli appunti per incollare la mappa in un’altra applicazione come LibreOffice, GIMP...

7.4 Visualizzazione Mappa 3D

1l servizio di rappresentazione 3D ¢ offerto attraverso la visualizzazione della mappa in 3D. Si crea e si apre una vista

della mappa 3D tramite Visualizza » ":i Nuova Mappa 3D. Apparira un pannello QGIS fluttuante. Il pannello pud
essere ancorato.

Per cominciare, la visualizzazione della mappa 3D ha la stessa estensione e la stessa visualizzazione della mappa
principale 2D. Sono disponibili una serie di strumenti di navigazione per trasformare la visualizzazione in 3D.

3D Map 1 @

O ROR=shhe wy

] A »
N
4W/Eb
s
2 v 2

Interpolation | OutQuad  ~ |

Keyframe |Ss
L e e

Loop
Fig. 7.7: La finestra di dialogo visualizzazione Mappa 3D

I seguenti strumenti sono disponibili nella parte superiore del pannello di visualizzazione della mappa 3D:
. @ Controllo fotocamera; gt Ja visualizzazione, mantenendo lo stesso angolo e la stessa direzione della telecamera

. ;: Zoom Completo. ridafinisce la visualizzazione all’estensione di tutti i layer
Y
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A
(

\_/ Attiva navigazione su schermo. mogtra/nasconde il widget di navigazione (che ha lo scopo di facilitare il controllo
della visualizzazione della mappa)

Q& Informazioni. regtitnisce informazioni sul punto del terreno cliccato o sul(sugli) oggetto(i) 3D cliccato(i) —
Maggiori dettagli in Informazione Elementi

[ Linea di Misura.: mjqura la distanza orizzontale tra i punti

P> Animazioni. 11 06tra/nasconde il widget animation player

g salva come immagine.... esporta la vista corrente in un formato file immagine

6 Esporta scena 3. . osnorta la vista corrente come scena 3D (:file:.obj file), permettendo il post-processing
in applicazioni come Blender... Il terreno e gli elementi del vettore vengono esportati come oggetti 3D. Le
impostazioni di esportazione, sovrascrivendo layer proprieta o visualizzazione mappa configuration, includono:

— Nome scena e destinazione Cartella

Risoluzione terreno

Risoluzione trama del terreno

Scala del modello

_ = Bordi smussati

g Esporta normali

_ & Esporta trame

@, Imposta il tema della vista, ¢ permette di selezionare l'insieme dei layer da visualizzare nella visualizzazione mappa
dai temi predefiniti mappa.

“ Configura 15 vista mappa sertings

7.4.1 Opzioni di navigazione

Per esplorare la vista della mappa in 3D:

Inclina il terreno (ruotandolo attorno ad un asse orizzontale che passa attraverso il centro della finestra)

[ ™ - b)) L
Premi gli strumenti = Inclina in alto e i Inclina in basso.

Premi Shift e usai tasti su/giu.

Trascina il mouse avanti/indietro con il pulsante centrale del mouse premuto

— Premi Shift e trascina il mouse avanti/indietro con il pulsante sinistro del mouse premuto.
Ruota il terreno (intorno ad un asse verticale che passa attraverso il centro della finestra)

— Ruota la bussola del widget di navigazione verso la direzione di osservazione

Premi Shift e usa i tasti sinistra/destra.

Trascina il mouse a destra/sinistra con il pulsante centrale del mouse premuto

Premi Shift e trascina il mouse a destra/sinistra con il pulsante sinistro del mouse premuto.

Cambia la posizione della telecamera (e il centro della visuale), spostandola in un piano orizzontale

Li;
— Trascina il mouse con il tasto sinistro del mouse premuto e il tasto {I_J Controllo Fotocamera. apyilitato

— Premi le frecce direzionali del widget di navigazione
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— Utilizza i tasti su/giu/sinistra/destra per spostare la telecamera rispettivamente in avanti, indietro, destra
e sinistra

* Modifica la quota della telecamera: premi i tasti Page Up/Page Down

¢ Cambia l'orientamento della telecamera (la telecamera viene mantenuta nella sua posizione ma il punto centrale
di vista si sposta)

— Premi Ctr1 e usai tasti freccia per ruotare la telecamera in alto, in basso, a sinistra e a destra
— Premi Ctrl e trascina con il tasto sinistro del mouse premuto

¢ Ingrandisci e rimpicciolisci

I Y
=
—

— Premi gli strumenti &~ Rimpicciolisci ¢ - Ingrandisci. je] widget di navigazione
— Muovi la rotellina del mouse (tenendo premuto Ct r1 si ottengono zoom pill precisi)
— Trascina il mouse con il tasto destro del mouse premuto per ingrandire (trascina verso il basso) e ridurre

(trascina verso I'alto)

L) ) .
Per ripristinare la visualizzazione della fotocamera, fai clic sul pulsante &% Zoom ad estensione massima pe]]5 parte superiore
del pannello della mappa 3D.

7.4.2 Creare una animazione

Una animazione si basa su una serie di fotogrammi chiave - le posizioni della telecamera in determinati momenti.
Per creare un’animazione:
’ Animazioni

1. Attiva lo strumento , per visualizzare il widget del generatore dell’animazione

2. Fai clic sul pulsante E:'I::':' Tempo fotogramma chiave

chiave visualizza ora il tempo impostato.

e inserisci un 7empo in secondi. La casella combinata Fotogramma

3. Utilizzando gli strumenti di navigazione, sposta la telecamera nella posizione da associare all’attuale tempo del
fotogramma chiave.

4. Ripeti i passi precedenti per aggiungere tanti fotogrammi chiave (con tempo e posizione) nella quantita voluta.

5. Fai clic sul pulsante > per visualizzare I'anteprima dell’animazione. QGIS generera le scene utilizzando le
posizioni/rotazioni della telecamera agli orari prestabiliti e interpolandole tra questi fotogrammi chiave. Sono
disponibili varie modalita di Interpolazione per le animazioni ( ad esempio, lineari, inQuad, inQuad, outQuad,
inCirc... — maggiori dettagli su https://doc.qt.io/qt-5/qeasingcurve.html#EasingFunction-typedef)

L’animazione puo anche essere visualizzata in anteprima spostando il cursore del tempo. Mantenendo premuto

>

o
il pulsante % RiPeti Panimazione verra eseguita ripetutamente, mentre cliccando su si ferma un’animazione

in esecuzione.

E possibile esplorare le diverse viste della telecamera, utilizzando I'elenco Keyframe. Ogni volta che un orario &
attivo, cambiando la vista della mappa si aggiorna automaticamente la posizione associata. Puoi anche gestire con

s +¢| Aggiungi fotogramma chiave ==] Rimuovi fotogramma chiave
IsimbologyEditl (solo tempo) o .
. . E t f [ 1 d 1 1 . .. . .
Fai clic su fx¥ ©sporta fologrammi diammazione ner- oenerare una serie di immagini che rappresentano la scena. Oltre al nome

del file Modello e alla Cartella di uscita, puoi impostare il numero di Frame per secondo, 1” Larghezza di uscita e 1”
Altezza di uscita.
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7.4.3 Impostazione della scena

La vista della mappa 3D si apre con alcune impostazioni predefinite che ¢ possibile personalizzare. Per farlo, fai clic
sul pulsante &, Configura po]j parte superiore del pannello dell’area di disegno 3D per aprire la finestra Configurazione

3D.
3D Configuration X

Lights

Type DEM (Raster Layer) -

@ sShadow - ( X

,‘-' Camera & Skybox Elevation = dtm =

% Advanced Vertical scale 1.00 -
Tile resolution 16 pX =
skirt height 10.0 map units =

Terrain Shading
©Help @apply || ©cancel QoK

Fig. 7.8: La finestra di dialogo Configurazione 3D
Nella finestra di Configurazione 3D ci sono diverse opzioni per mettere a punto la scena 3D:

Terreno

* Terreno: Prima di immergersi nei dettagli, vale la pena notare che il terreno in una vista 3D ¢ rappresentato
da una gerarchia di tasselli di terreno e, man mano che la macchina fotografica si avvicina al terreno, i tasselli
esistenti che non hanno sufficienti dettagli vengono sostituite da tasselli piti piccoli con pitl dettagli. Ogni tassello
ha una geometria a maglie derivata dal layer di elevazione raster e dalla trama dei layer della mappa 2D.

— 11 Tipo di terreno in elevazione puo essere:
« un Terreno pianeggiante

« un layer DEM (Raster)

* un servizio Online, che carica le elevation tiles prodotte dagli strumenti Mapzen — maggiori dettagli
su https://registry.opendata.aws/terrain-tiles/

+ un dataset caricato in formato Mesh

— Altitudine: Layer raster o mesh da usare per la generazione del terreno. Il layer raster deve contenere una
banda che rappresenti I’elevazione. Per un layer mesh, vengono usati i valori Z dei vertici.

— Scala verticale: fattore di scala per I'asse verticale. Aumentando la scala si esagera I'altezza del terreno.

— Risoluzione tassello: quanti campionamenti del layer raster del terreno vanno utilizzate per ogni tassello.
Un valore di 16px significa che la geometria di ogni tassello sara composto da campionamenti di

elevazione 16x16. Numeri piu alti creano tasselli del terreno piu dettagliati a scapito di una maggiore
complessita di rappresentazione.
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— Altezza bordo: A volte & possibile vedere piccole crepe tra i tasselli del terreno. Aumentando questo valore
si aggiungono pareti verticali («bordi») intorno ai tasselli del terreno per nascondere le crepe.

* Quando un layer mesh & usato come terreno, puoi configurare le impostazioni Levigatura triangoli
(visualizzazione wireframe, triangoli lisci) e le impostazioni Stile di visualizzazione (come uniforme o in base
al livello del terreno). Maggiori dettagli nella sezione Mesh layer properties.

o ! Ombreggiatura del terreno: Ti permette di scegliere come visualizzare il terreno:
— Ombreggiatura disabilitata - il colore del terreno ¢ determinato solo dalla tessitura raster della mappa

— Ombreggiatura abilitata - il colore del terreno & determinato utilizzando il modello di ombreggiatura di
Phong, tenendo conto della texture della mappa, del vettore normale del terreno, della(e) luce(e) della
scena e del colore del terreno Ambiente e Speculare e Lucentezza.

Luci

Dalla scheda Luci, premi il menu su ':II'I-II:I per aggiungere

* fino a otto Punti luce: emette luce in tutte le direzioni, come una sfera di luce che riempie un’area. Gli oggetti
piu vicini alla luce saranno piu luminosi, e gli oggetti piti lontani saranno piut scuri. Una luce puntiforme ha
impostata una posizione (X, Y e Z), un Colore, una Intensita e una Attenuazione

¢ fino a quattro Luci direzionali: imita I'illuminazione che si otterrebbe da una luce flash di dimensioni gigantesche
molto lontana dai vostri oggetti, sempre centrata e che non si spegne mai (per esempio il sole). Emette dei raggi
di luce paralleli in una sola direzione, ma la luce si estende all'infinito. Una luce direzionale puo essere ruotata
impostando un Azimuth, avere una Alfitudine, un Colore e una Intensita.

3D Configuration X

Terrain Lights
[ J Sadcw . Pointlight 1 &
= Camera & Skybox . Pointlight 2 =

% Advanced ® Directional light 1

Light Direction

Wity
- '.'":‘ \}f' -
Azimuth |135.00° |~ -.\ )3 Altitude | 71.00° <
X -0.23 ¥ 095 £ -0.23
Color >
Intensity | 1.00 -
©Help @-apply || @cancel Qok

Fig. 7.9: La finestra di dialogo Luci della Configurazione 3D della Mappa
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Ombreggiatura

Seleziona Mostra Ombreggiatura per mostrare 'ombra nella tua scena, dato:

una Luce direzionale

una Distanza massima di visualizzazione delle ombre: per evitare la visualizzazione dell’ombra di oggetti troppo
distanti, per esempio quando la telecamera si alza lungo 'orizzonte

un livello di Bias ombra: per evitare effetti di auto-ombra che potrebbero restituire alcune aree piu scure di
altre, a causa delle differenze nelle dimensioni della mappa. Piu basso &, meglio ¢

una Risoluzione della mappa delle ombre: per rendere le ombre piu nitide. Pud portare a problemi nelle
prestazioni se il parametro di risoluzione ¢ troppo alto.

Camera & Skybox

Camera Campo di vista: permette di creare scene panoramiche. Il valore predefinito ¢ 45°.

Seleziona Mostra Sybox per abilitare la visualizzazione dello skybox nella scena. Il tipo di skybox puo
essere:

— Trama Panoramica, con un singolo file che fornisce la vista su 360°
— Facce Distinte, con un file trama per ciascuno dei sei lati di una scatola contenente la scena

I file di trama possono essere file sul disco, URL remoti o incorporati nel progetto (more details).

Avanzato

Risoluzione tasselli Mappa: Larghezza e altezza delle immagini della mappa 2D usate come suddivisione in
tasselli del terreno. 256px significa che ogni tassello sara visualizzato in un’‘immagine di 256x256 pixel. Un
numero pill alto crea tasselli di terreno piu dettagliate a scapito di una maggiore complessita di visualizzazione.

Max. errore di schermo: Determina la soglia per sostituire i tasselli del terreno con altri pill dettagliati (e
viceversa) - cio¢ quanto tempo la vista 3D utilizzera tasselli di qualita superiore. Un numero inferiore significa
maggiori dettagli della scena a scapito di una maggiore complessita di visualizzazione.

Max. errore al suolo: La risoluzione dei tasselli del terreno in cui si interrompe la divisione delle tasselli in
tasselli piu dettagliati (dividerli non introdurrebbe comunque alcun dettaglio in pilt). Questo valore limita la
profondita della gerarchia dei tasselli: valori pilt bassi rendono la gerarchia profonda, aumentando la complessita
di visualizzazione.

Livelli di zoom: Mostra il numero di livelli di zoom (dipende dalla risoluzione dei tasselli della mappa e
dall’errore massimo al suolo).

Mostra etichette: Attiva/disattiva le etichette della mappa

Mostra le info sui tasselli della mappa: Include i numeri dei tasselli di confine e dei tasselli del terreno (utile
per la soluzione delle tematizzazioni del terreno).

Mostra i perimetri di delimitazione: Mostra i perimetri di delimitazione 3D dei tasselli del terreno (utile per
la soluzione delle tematizzazioni del terreno)

Mostra il centro di vista della camera

Mostra sorgenti luminose: mostra una sfera come origine delle fonti di luce, permettendo un piu facile
riposizionamento e posizionamento delle fonti di luce rispetto ai contenuti della scena

52

Capitolo 7. QGIS GUI



QGIS Desktop 3.16 User Guide

7.4.4 Layer vettoriali 3D

Un layer vettoriale con valori di elevazione pud essere mostrato nella mappa 3D controllando Configura nella scheda
Nuova mappa 3D delle proprieta del layer vettoriale. Sono disponibili diverse opzioni per controllare la visualizzazione
del layer vettoriale 3D.

7.5 Barra di Stato

La barra di stato ti fornisce informazioni generali sulla visualizzazione della mappa e sulle azioni elaborate o
disponibili e ti offre strumenti per gestire la visualizzazione della mappa.

7.5.1 Barra Localizzatore

Sul lato sinistro della barra di stato, la barra di localizzazione, un widget di ricerca rapida, ti aiuta a trovare ed eseguire
qualsiasi elemento o opzione in QGIS:

1. Clicca nel widget di testo per attivare la barra di ricerca del localizzatore o premi Ct r 1 +K.

2. Digita un testo associato all’elemento che stai cercando (nome, tag, parola chiave, ...). Per impostazione
predefinita, i risultati vengono restituiti per i filtri di localizzazione abilitati, ma puoi limitare la ricerca ad
un certo ambito facendo precedere il testo dal prefisso locator filters, ad esempio digitando 1 cad’ verranno
restituiti solo i layer il cui nome contiene cad.

11 filtro pud anche essere selezionato con un doppio clic nel menu che appare quando si accede al widget del
localizzatore.

3. Clicca su un risultato per eseguire I'azione corrispondente, a seconda del tipo di elemento.

Suggerimento: Limitare la ricerca a un campo del layer attivo

Per impostazione predefinita, una ricerca con il filtro «active layer features» (£) scorre l'intera tabella degli attributi
del layer. Puoi limitare la ricerca ad un campo particolare usando il prefisso @. Per esempio, £ @name sal o
@name sal restituisce solo gli elementi il cui attributo «name» contiene “sal”. Il completamento automatico del
testo ¢ attivo durante la scrittura e il suggerimento puo essere applicato usando il tasto Tab.

La ricerca ¢ gestita utilizzando i thread, in modo che i risultati siano sempre disponibili il pitt rapidamente possibile,
anche se sono installati filtri di ricerca lenti. Inoltre appaiono non appena vengono incontrati da un filtro, il che
significa che, ad esempio, un filtro di ricerca di file mostrera i risultati uno per uno man mano che I'albero dei file
viene analizzato. Questo assicura che l'interfaccia utente sia sempre reattiva, anche se ¢ presente un filtro di ricerca
molto lento (per esempio uno che usa un servizio online).

Suggerimento: Accesso rapido alla configurazione del Localizzatore

Fai clic sull’icona allinterno del widget del localizzatore sulla barra di stato per visualizzare la lista dei filtri che
puoi usare e una voce Filtro che apre la scheda Localizzatore del menu Impostazioni » Ozioni....
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7.5.2 Azioni di reporting

Nell’area accanto alla barra di localizzazione, quando necessario ti verra mostrato un riepilogo delle azioni eseguite
(come la selezione di elementi in un layer, la rimozione del layer) o una completa descrizione dello strumento su cui
si passa sopra (non disponibile per tutti gli strumenti).

In caso di lunghe operazioni, come I'acquisizione di statistiche in layer raster, 'esecuzione di algoritmi di elaborazione
o la visualizzazione di piu layer nella mappa, nella barra di stato viene visualizzata una barra dello stato di
avanzamento.

7.5.3 Gestione della mappa

L’opzione % Coordinate mostra la posizione corrente del mouse, seguendolo durante lo spostamento sulla mappa.
Puoi impostare le unita di misura (e la precisione) nella scheda Progetto » Proprieta... » Generale. Clicca sul piccolo

pulsante a sinistra della casella di testo per passare dall’'opzione Coordinate all’opzione @ Estensioni che mostra le
coordinate in unita mappa degli attuali angoli in basso a sinistra e in alto a destra della mappa.

Accanto al display delle coordinate si trova il display Scala. Mostra la scala della visualizzazione della mappa. C’¢ un
selettore di scala, che permette di scegliere tra predefined and custom scales.

Sul lato destro del display della scala, premi il pulsante ﬂ per bloccare la scala e utilizza la lente di ingrandimento
per ingrandire o ridurre lo zoom. La lente d’ingrandimento consente di ingrandire una mappa senza alterare la scala
della mappa, rendendo piu facile modificare con precisione la posizione delle etichette e dei simboli. Il livello di
ingrandimento & espresso in percentuale. Se Livello di ingrandimento ha un livello del 100%, allora la mappa corrente
non viene ingrandita. Inoltre, un valore di ingrandimento predefinito pud essere impostato all'interno di Impostazioni »
Opzioni... » Visualizzazione w Livello ingrandimento, che ¢ molto utile per schermi ad alta risoluzione per ingrandire
simboli piccoli.

A destra della scala puoi definire la rotazione corrente in gradi in senso orario della mappa.

Sul lato destro della barra di stato, c’@ una piccola casella di controllo che puod essere usata temporaneamente per
impedire che i layer vengano aggiornati nella visualizzazione mappa (vedi la sezione Visualizzazione).

A destra delle funzioni di visualizzazione, trovi il pulsante & EPSG:code che mostra il SR del progetto corrente.
Cliccando su questo pulsante si apre la finestra di dialogo Proprieta progetto e ti consente di applicare un altro SR alla
visualizzazione della mappa.

Suggerimento: Calcolare la scala corretta della mappa

Quando avvii QGIS, il SR predefinito ¢ WGS 84 (EPSG 4326) e le unita di misura sono i gradi. Cio significa
che QGIS interpretera qualsiasi coordinata del layer come specificato in gradi. Per ottenere valori di scala corretti, &
possibile modificare manualmente questa impostazione nella scheda Generale sotto Progetto » Proprieta... (ad es. ai

metri), oppure & possibile utilizzare icona == EPSGeode yigta sopra. In quest’ultimo caso, le unita sono impostate a

quanto specificato dalla proiezione del progetto (ad esempio, +units=us-£ft).

Da notare che la scelta del sistema SR di partenza puo essere fatta in Impostazioni » Opzioni » SR.
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7.5.4 Messaggi

1l pulsante Q Messagei accanto ad esso apre il pannello Messaggi di Log che contiene informazioni sui processi in
corso (attivazione di QGIS, caricamento di plugin, strumenti di processing....).

A seconda delle impostazioni di Plugin Manager settings, la barra di stato puo a volte mostrare delle icone a destra

i
per informare sulla disponibilita di plugin nuovi () o aggiornabili (ﬁﬁ)_ Fai clic sull’icona per aprire la finestra di
dialogo di Plugin Manager.
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CAPITOLO 8

Il pannello Browser

Il pannello QGIS Browser ¢ un ottimo strumento per la navigazione, la ricerca, la consultazione, la copia e il
caricamento delle risorse QGIS. Solo le risorse che QGIS sa come gestire sono mostrate nel browser.

Utilizzando il pannello Browser ¢ possibile individuare, visualizzare e aggiungere dati, come descritto in /I Pannello
Browser. Inoltre, il pannello Browser supporta il drag and drop di molte risorse QGIS, come file di progetto, script
Python, script di Processing e modelli di Processing.

Gli script Python, gli script di Processing e i modelli di Processing possono anche essere aperti per I'editing in un
editor esterno e nel modellatore grafico.

Puoi trascinare e rilasciare i layer dal pannello Layer al pannello Browser, ad esempio in un GeoPackage o in un
database PostGIS.
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Browser () (]
e THO
3 Favorites
» " Spatial Bookmarks
» [¢] Home
» 55/
» & GeoPackage
» # SpatiaLite
» @ Postcls
P MssQL
& pB2
b B WMS/WMTS
# vector Tiles
o: XYZ Tiles
& WCS
W7 WFS / OGC API - Features
) OWS
& ArcGIS Map Service
&~ ArcGIS Feature Service
3¢ GeoNode

v v v

Fig. 8.1: Il pannello Browser

11 pannello del browser (Fig. 8.1) & organizzato in una gerarchia espandibile con alcune voci fisse al primo livello che

organizzano le risorse gestite dal browser. Le voci di primo livello vengono espanse cliccando su 4 a sinistra del
. . w A Racehiudi Tutto .

nome della voce. Un ramo viene collassato cliccando su . I pulsante artutio fa collassare tutte le voci al

primo livello.

In Impostazioni » Personalizzazione Interfaccia € possibile disabilitare le risorse. Se, per esempio, non vuoi mostrare
script Python nel browser, puoi deselezionare la voce Browser » py, e se vuoi eliminare la cartella home nel browser,
puoi deselezionare la voce Browser » special:Home.

Un filtro (? Filira Browser) 110y essere utilizzato per la ricerca in base ai nomi delle voci (sia le voci delle foglie che
quelle dei nodi nella gerarchia). Utilizzando il menu a tendina ™ ©Pon accanto al campo di testo del filtro, puoi
* attivare/disattivare I'opzione Maiusc/minusc
 impostare Filtra sintassi del pattern su una di queste opzioni
— Normale
— Carattere(i) jolly

— Espressione Regolare
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11 widget Proprieta, che mostra informazioni utili su alcune voci / risorse, puo essere abilitato / disabilitato usando il

pulsante @ Abilita/disabilita le proprieta del widget (yyando & abilitato, si apre in fondo al pannello del browser, come mostrato
in Fig. 8.2.

Browser = ()
LY 10
v~ @ GeoPackage -

» = testgeopackage.gpkg
* & training_data.gpkg
-~ buildings

™ restaurants

L

/" roads
- schools
» = vector_analysis.gpkg
» /# SpatiaLite
~ @ Postals
4 3

Metadata | Preview  Attributes

Information from provider

Name restaurants

Path homel/tveite/Downloads/QGIS/IQGIS-Training-
Data-release 3.10/exercise data/
training data.gpkg

Source /home/tveite/Downloads/QGIS/0OGIS-Training- 4

Fig. 8.2: 1l widget proprieta

Un secondo pannello browser puo essere aperto attivando il pannello Browser (2) in Visualizza » Panelli. Avere due
pannelli browser puo essere utile quando si copiano i layer tra le risorse che si trovano in profondita in diversi rami
della gerarchia del browser.

8.1 Risorse che possono essere aperte / eseguite dal Browser

Molto si puo fare nel pannello Browser
» Aggiungere layer vettoriali, raster e mesh alla mappa facendo doppio clic, trascinando sull’area della mappa o
cliccando sul pulsante q Aggiungi Layer selezionati (opo aver selezionato i layer)

* Eseguire script Python (inclusi gli algoritmi di Processing) facendo doppio clic o trascinandoli sull’area della
mappa

 Eseguire modelli facendo doppio clic o trascinandoli nell’area della mappa
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e Estrai simboli... dai file di progetto QGIS utilizzando il menu contestuale

* Aprire file con le loro applicazioni predefinite (Open <file type> Externally... nel menu contestuale). Ad
esempio: file HTML, fogli di calcolo, immagini, PDF, file di testo, ...

* Copiare voci

Le azioni specifiche per le risorse sono elencate per i diversi gruppi di risorse ordinate sotto le voci di primo livello
elencate qui di seguito.

8.2 Voci di primo livello del pannello Browser

8.2.1 Preferiti

Spesso le posizioni del file system utilizzate possono essere etichettate come preferite. Quelle che hai etichettato
appariranno qui.

Oltre alle operazioni descritte in Home, il menu contestuale ti permette di impostare Rinomina Preferito... e Rimuovi
Preferito.

8.2.2 Segnalibri Spaziali

Qui troverai i tuoi segnalibri spaziali, organizzati in Segnalibri Progetto e Segnalibri Utente.

Dal menu contestuale di livello superiore, puoi creare un segnalibro (Nuovo Segnalibro Spaziale...), Mostra Gestore
Segnalibri Spaziali, Importa Segnalibri Spaziali... e Esporta Segnalibri Spaziali....

Per le voci dei segnalibri puoi Zoom a Segnalibro, Modifica Segnalibro Spaziale... e Elimina Segnalibro Spaziale.

8.2.3 Home

La directory/cartella home del tuo file system. Cliccando con il tasto destro del mouse su una voce, e scegliendo
Aggiungi come Preferito, la posizione verra aggiunta a Preferiti. Dal menu contestuale, puoi anche

* aggiungere una cartella, un Geopackage o un ESRI Shapefile (Nuovo)
* nascondere la cartella (Nascondi dal Browser)

« attivare/disattivare Scansiona Velocemente questa cartella.

* aprire la cartella nel tuo file manager (Apri Cartella...)

e aprire la cartella in una finestra del terminale (Apri nel Terminale...)

* ispezionare le proprieta (Proprieta..., Proprieta Cartella...)

8.24 /

La tua directory / cartella principale del file system.

60 Capitolo 8. Il pannello Browser



QGIS Desktop 3.16 User Guide

8.2.5 Geopackage
File Geopackage / database. Dal menu contestuale di livello superiore, puoi creare un file / database Geopackage
(Crea Database...) o aggiungere un file / database Geopackage esistente (Nuova Connessione...).

Il menu contestuale di ogni Geopackage ti permette di rimuoverlo dalla lista (Rimuovi connessione...), aggiungere un
nuovo layer o una nuova tabella al Geopackage (Crea nuovo layer o tabella...), cancellare il Geopackage (Cancella
<name of geopackage>) e Compatta Database (VACUUM).

Per le voci di layer/tabella puoi
e rinominarlo (Rinominare Layer <layer name>...)
* esportarlo (Esporta Layer » Su File...)
* aggiungerlo al progetto Aggiungi Layer al Progetto
e eliminarlo (Elimina File...)

* consultare le proprieta (Proprieta del Layer..., Proprieta File...)

8.2.6 Spatial.ite

Connessioni al database SpatiaLite.

Dal menu contestuale di livello superiore, puoi creare un file / database SpatiaLite (Crea Database...) o aggiungere
un file / database SpatiaL.ite esistente (Nuova Connessione...).

Il menu contestuale di ogni file SpatiaL.ite ti permette di cancellarlo (Elimina).
Per le voci di layer/tabella puoi

* esportarlo (Esporta Layer » Su File...)

* aggiungerlo al progetto Aggiungi Layer al Progetto

e eliminarlo (Elimina File...)

* consultare le proprieta (Proprieta Layer...)

8.2.7 PostGIS

Connessioni al database PostGIS.
Dal menu contestuale di livello superiore, puoi aggiungere una nuova connessione (Nuova Connessione...).

Il menu contestuale di ogni connessione ti permette di Aggiornare, modificare Modifica connessione..., cancellare
(Rimuovi connessione) o Creare Schema....

Il menu contestuale di ogni schema ti permette di Aggiornare, Rinominare Schema... o Eliminare Schema.
Per layer/tabelle tu puoi

e rinominarlo (Rinomina Tabella...)

¢ rimuovere il suo contenuto (Truncate Tabella...)

* esportarlo (Esporta Layer » Su File...)

* aggiungerlo al progetto (Aggiungi Layer al Progetto)

e climinarlo (Elimina File...)

* visualizzare le sue proprieta (Proprieta Layer...)
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8.2.8 MSSQL

Connessioni Microsoft SQL Server.
Dal menu contestuale di livello superiore, puoi aggiungere una nuova connessione (Nuova Connessione...).

Il menu contestuale di ogni connessione ti permette di Aggiornare, modificare Modifica connessione..., cancellare
(Rimuovi connessione) o Creare Schema....

Il menu contestuale di ogni schema ti permette di Aggiornare, Rinominare Schema... o Eliminare Schema.
Per layer/tabelle tu puoi

e rinominarlo (Rinomina Tabella...)

¢ rimuovere il suo contenuto (Truncate Tabella...)

* esportarlo (Esporta Layer » Su File...)

* aggiungerlo al progetto (Aggiungi Layer al Progetto)

e climinarlo (Elimina File...)

* visualizzare le sue proprieta (Proprieta Layer...)

8.2.9 DB2

Connessioni al database IBM DB2.
Dal menu contestuale di livello superiore, puoi aggiungere una nuova connessione (Nuova Connessione...).

Il menu contestuale di ogni connessione ti permette di Aggiornare, modificare Modifica connessione..., cancellare
(Rimuovi connessione) o Creare Schema....

Il menu contestuale di ogni schema ti permette di Aggiornare, Rinominare Schema... o Eliminare Schema.
Per layer/tabelle tu puoi

e rinominarlo (Rinomina Tabella...)

¢ rimuovere il suo contenuto (Truncate Tabella...)

* esportarlo (Esporta Layer » Su File...)

* aggiungerlo al progetto (Aggiungi Layer al Progetto)

e eliminarlo (Elimina File...)

* visualizzare le sue proprieta (Proprieta Layer...)

8.2.10 WMS/WMTS

Web Map Services (WMS) e Web Map Tile Services (WMTS)
Dal menu contestuale di livello superiore, puoi aggiungere una nuova connessione (Nuova Connessione...).
Il menu contestuale di ogni servizio WSM/WMTS ti permette di Aggiornare, Modificare... e cancellare (Elimina).
Layer in gruppo possono essere aggiunti trascinandoli sull’area della mappa.
Per i layer WMS/WMTS puoi
* esportarlo (Esporta Layer » Su File...)
* aggiungerlo al progetto (Aggiungi Layer al Progetto)

* consultare le proprieta (Proprieta Layer...)
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8.2.11 Vector Tile

Servizi Vector tile

Dal menu contestuale di livello superiore, aggiungi un servizio esistente (Nuova Connessione...), € puoi Salva
Connessione... o Carica Connessione... a / da file XML.

8.2.12 XYZ Tile

servizi XYZ tile

Dal menu contestuale di livello superiore, aggiungi un servizio esistente (Nuova Connessione...), € puoi Salva
Connessione... o Carica Connessione... a / da file XML.

Per i servizi XYZ tile puoi
» modificarlo (Modifica...)
e eliminarlo (Elimina)
* esportarlo (Esporta Layer » Su File...)
* aggiungerlo al progetto Aggiungi Layer al Progetto

* consultare le proprieta (Proprieta Layer...)

8.2.13 WCS

Web Coverage Services
Dal menu contestuale di livello superiore, puoi aggiungere una nuova connessione (Nuova Connessione...).
Il menu contestuale di ogni WCS ti permette di Aggiornare, Modificare... e cancellare (Eliminare).
Per i layer WCS puoi
* esportarlo (Esporta Layer » Su File...)
* aggiungerlo al progetto (Aggiungi Layer al Progetto)

* consultare le proprieta (Proprieta Layer...)

8.2.14 WFS / OGC API - Features

Web Feature Services (WFS) e OGC API - Features services (alias WFS3)
Dal menu contestuale di livello superiore, puoi aggiungere una nuova connessione (Nuova Connessione...).
Il menu contestuale di ogni WFS ti permette Aggiornare, Modificare... e cancellare (Eliminare).
Per i layer WFS puoi
* esportarlo (Esporta Layer » Su File...)
* aggiungerlo al progetto (Aggiungi Layer al Progetto)

* consultare le proprieta (Proprieta Layer...)
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8.2.15 OWS

Qui trovi una lista in solo lettura di tutti i tuoi Open Web Services (OWS) - WMS / WCS / WFS/ WFS / ...

8.2.16 ArcGIS Map Service
8.2.17 ArcGIS Features Service

8.2.18 GeoNode

Dal menu contestuale di livello superiore, puoi aggiungere una nuova connessione (Nuova Connessione...).
Il menu contestuale di ogni servizio ti permette di Aggiornare, Modificare... e cancellare (Eliminare).
Con le voci di gestione dei layer puoi

* esportarlo (Esporta Layer » Su File...)

* aggiungerlo al progetto (Aggiungi Layer al Progetto)

* consultare le proprieta (Proprieta Layer...)

8.3 Risorse

* File di progetto. Il menu contestuale per i file di progetto QGIS ti permette di:
— caricarlo (Apri Progetto)

— estrarre simboli (Estrai Simboli...) - apre il gestore di stili che permette di esportare simboli in un file
XML, aggiungere simboli allo stile predefinito o esportarli come PNG o SVG.

— consultare proprieta (Proprieta File...)

Puoi espandere il file di progetto per vederne i layer. Il menu contestuale di un layer offre le stesse opzioni
come nelle altre funzionalita del browser.

* File di definizione dei Layer QGIS (QLR). Le seguenti azioni sono disponibili dal menu contestuale:
— esportarlo (Esporta Layer » Su File...)
— aggiungerlo al progetto (Aggiungi Layer al Progetto)
— consultare le proprieta (Proprieta Layer...)
* Modelli di elaborazione (.modello3). Le seguenti azioni sono disponibili dal menu contestuale:
— (Esegui Modello...)
— (Modifica Modello...)
* Modelli di compositore di stampa QGIS (QPT). La seguente azione ¢ disponibile dal menu contestuale:
— (Nuovo Layout da Modello)
* Script Python (.py). Le seguenti azioni sono disponibili dal menu contestuale:
— (Esegui script...)
— (Apri in un editor esterno)
» Formati raster riconosciuti. Le seguenti azioni sono disponibili dal menu contestuale:
— eliminarlo (Elimina File <dataset name>)
— esportarlo (Esporta Layer » Su File...)

— aggiungerlo al progetto (Aggiungi Layer al Progetto)
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— consultare le proprieta (Proprieta del Layer..., Proprieta File...)
Per alcuni formati puoi anche Apri <file type> Esternamente...

» Formati vettoriali riconosciuti. Le seguenti azioni sono disponibili dal menu contestuale:

eliminarlo (Elimina File <dataset name>)

esportarlo (Esporta Layer » Su File...)

aggiungerlo al progetto (Aggiungi Layer al Progetto)

consultare le proprieta (Proprieta del Layer..., Proprieta File...)

Per alcuni formati puoi anche Apri <file type> Esternamente...
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cAPITOLO 9

Configurazione QGIS

QGIS ¢ altamente configurabile. Tramite il menu Impostazioni, fornisce diversi strumenti per:
. , . .
o B2 Gestore Stile...: crea e gestisce symbols, styles and color ramps.

iy
o 51 Proiezione personalizzata...: crea il tuo coordinate reference systems.

0
e OO Scociatoie da Tastiera...: defininisce il tuo set di keyboard shortcuts. Inoltre le stesse possono essere
sovrascritte nel corso di ogni sessione QGIS dalle project properties (accessibili nel menu Project).

. @ Personalizzazione interfaccia...: configura application interface, nascondendo finestre di dialogo o strumenti
di cui non hai bisogno.

o N Opzioni...: impostazioni globali options da applicare in diverse aree del software. Queste preferenze vengono
salvate nelle impostazioni del profilo attivo User profile e applicate di default ogni volta che si apre un nuovo
progetto con questo profilo.

9.1 Opzioni

“ Alcune opzioni di base per QGIS possono essere impostate nella finestra di dialogo Opzioni. Seleziona I'opzione
del menu Impostazioni » % Opzioni. Puoi modificare le opzioni in accordo alle tue necessita. Alcune delle modifiche
potrebbero richiedere il riavvio di QGIS prima di diventare effettive.

Le schede in cui puoi personalizzare le tue opzioni sono descritte di seguito.

Nota: I plugin possono gestire proprie impostazioni nella finestra di dialogo Opzioni

Mentre solo le impostazioni di base sono presentate di seguito, si noti che questa lista puo essere estesa da installed
plugins implementando proprie opzioni nella finestra di dialogo Opzioni standard. Questo evita che ogni plugin abbia
la propria finestra di dialogo di configurazione con voci di menu extra solo per loro.....
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9.1.1 Impostazioni generali

Definizioni sostitutive nazionali

Per impostazione predefinita, QGIS si basa sulla configurazione del tuo sistema operativo per impostare la lingua e
manipolare i valori numerici. L’abilitazione di questo gruppo ti permette di personalizzare il comportamento.

Seleziona in Traduzione interfaccia utente la lingua da applicare alla GUI

Seleziona in Localizzazione (formato per numeri, data e valuta) il formato di immissione e visualizzazione dei
valori numerici e delle date

oA Mostra separatore delle migliaia

Nella parte inferiore della scheda viene visualizzato un riepilogo delle impostazioni selezionate e della loro
riproduzione.

Applicazione

Seleziona lo Stile (Riavvio di QGIS necessario) ad esempio come i widget appaiono e si posizionano nelle finestre
di dialogo. I valori possibili dipendono dal sistema operativo.
Definisci il tema UI (Riavvio di QGIS necessario) ' hd
Gray”.

. Puo essere “default”, “Night Mapping”, o “Blend of

Definisci la Dimensione delle icone ' v

Definisci il Carattere e la sua Dimensione. 1l font puo essere ¢ Ot predefinito o uno definito dall’'utente

Cambia il Timeout per messaggi o dialoghi a tempo.
Nascondi schermata iniziale all'avvio

o Mostra il feed di notizie QGIS sulla pagina di benvenuto: ti mostra un feed di notizie aggiornate su QGIS
nella pagina di benvenuto, dandoti un modo diretto per essere a conoscenza delle notizie del progetto (data e
sommario degli incontri utente/sviluppatore, sondaggi della comunita, annunci di rilascio, suggerimenti vari. ..)

o Controlla la versione QGIS all'avvio per tenerti informato se & stata rilasciata una versione piu recente
Utilizza le finestre di dialogo per la scelta dei colori nativi (vedi Scelta colore)

Finestra non modale di gestione delle sorgenti dati per mantenere aperta la fines